
Advanced Design System 2011.01 - Windows Installation

1

Advanced Design System 2011.01

Feburary 2011
Windows Installation



Advanced Design System 2011.01 - Windows Installation

2

© Agilent Technologies, Inc. 2000-2011
5301 Stevens Creek Blvd., Santa Clara, CA 95052 USA
No part of this documentation may be reproduced in any form or by any means (including
electronic storage and retrieval or translation into a foreign language) without prior
agreement and written consent from Agilent Technologies, Inc. as governed by United
States and international copyright laws.

Acknowledgments
Mentor Graphics is a trademark of Mentor Graphics Corporation in the U.S. and other
countries. Mentor products and processes are registered trademarks of Mentor Graphics
Corporation. * Calibre is a trademark of Mentor Graphics Corporation in the US and other
countries. "Microsoft®, Windows®, MS Windows®, Windows NT®, Windows 2000® and
Windows Internet Explorer® are U.S. registered trademarks of Microsoft Corporation.
Pentium® is a U.S. registered trademark of Intel Corporation. PostScript® and Acrobat®
are trademarks of Adobe Systems Incorporated. UNIX® is a registered trademark of the
Open Group. Oracle and Java and registered trademarks of Oracle and/or its affiliates.
Other names may be trademarks of their respective owners. SystemC® is a registered
trademark of Open SystemC Initiative, Inc. in the United States and other countries and is
used with permission. MATLAB® is a U.S. registered trademark of The Math Works, Inc..
HiSIM2 source code, and all copyrights, trade secrets or other intellectual property rights
in and to the source code in its entirety, is owned by Hiroshima University and STARC.
FLEXlm is a trademark of Globetrotter Software, Incorporated. Layout Boolean Engine by
Klaas Holwerda, v1.7 http://www.xs4all.nl/~kholwerd/bool.html . FreeType Project,
Copyright (c) 1996-1999 by David Turner, Robert Wilhelm, and Werner Lemberg.
QuestAgent search engine (c) 2000-2002, JObjects. Motif is a trademark of the Open
Software Foundation. Netscape is a trademark of Netscape Communications Corporation.
Netscape Portable Runtime (NSPR), Copyright (c) 1998-2003 The Mozilla Organization. A
copy of the Mozilla Public License is at http://www.mozilla.org/MPL/ . FFTW, The Fastest
Fourier Transform in the West, Copyright (c) 1997-1999 Massachusetts Institute of
Technology. All rights reserved.

The following third-party libraries are used by the NlogN Momentum solver:

"This program includes Metis 4.0, Copyright © 1998, Regents of the University of
Minnesota", http://www.cs.umn.edu/~metis , METIS was written by George Karypis
(karypis@cs.umn.edu).

Intel@ Math Kernel Library, http://www.intel.com/software/products/mkl

SuperLU_MT version 2.0 - Copyright © 2003, The Regents of the University of California,
through Lawrence Berkeley National Laboratory (subject to receipt of any required
approvals from U.S. Dept. of Energy). All rights reserved. SuperLU Disclaimer: THIS
SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS

http://www.xs4all.nl/~kholwerd/bool.html
http://www.xs4all.nl/~kholwerd/bool.html
http://www.mozilla.org/MPL/
http://www.mozilla.org/MPL/
http://www.cs.umn.edu/~metis
http://www.cs.umn.edu/~metis
http://www.intel.com/software/products/mkl
http://www.intel.com/software/products/mkl


Advanced Design System 2011.01 - Windows Installation

3

INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

7-zip - 7-Zip Copyright: Copyright (C) 1999-2009 Igor Pavlov. Licenses for files are:
7z.dll: GNU LGPL + unRAR restriction, All other files: GNU LGPL. 7-zip License: This library
is free software; you can redistribute it and/or modify it under the terms of the GNU
Lesser General Public License as published by the Free Software Foundation; either
version 2.1 of the License, or (at your option) any later version. This library is distributed
in the hope that it will be useful,but WITHOUT ANY WARRANTY; without even the implied
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MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser
General Public License for more details. You should have received a copy of the GNU
Lesser General Public License along with this library; if not, write to the Free Software
Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is
hereby granted to use or copy this program under the terms of the GNU LGPL, provided
that the Copyright, this License, and the Availability of the original version is retained on
all copies.User documentation of any code that uses this code or any modified version of
this code must cite the Copyright, this License, the Availability note, and "Used by
permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice
that the code was modified is included. AMD Availability:
http://www.cise.ufl.edu/research/sparse/amd

UMFPACK 5.0.2 - UMFPACK Notice: The UMFPACK code was modified. Used by permission.
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redistribute it and/or modify it under the terms of the GNU Lesser General Public License
as published by the Free Software Foundation; either version 2.1 of the License, or (at

http://www.7-zip.org/
http://www.7-zip.org/
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program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies. User documentation of any
code that uses this code or any modified version of this code must cite the Copyright, this
License, the Availability note, and "Used by permission." Permission to modify the code
and to distribute modified code is granted, provided the Copyright, this License, and the
Availability note are retained, and a notice that the code was modified is included.
UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack  UMFPACK
(including versions 2.2.1 and earlier, in FORTRAN) is available at
http://www.cise.ufl.edu/research/sparse . MA38 is available in the Harwell Subroutine
Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at
http://www.cise.ufl.edu/research/sparse . COLAMD V2.0 is also incorporated as a built-in
function in MATLAB version 6.1, by The MathWorks, Inc. http://www.mathworks.com .
COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org ). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3
is a built-in routine in MATLAB 7.1.

Qt Version 4.6.3 - Qt Notice: The Qt code was modified. Used by permission. Qt copyright:
Qt Version 4.6.3, Copyright (c) 2010 by Nokia Corporation. All Rights Reserved. Qt
License: Your use or distribution of Qt or any modified version of Qt implies that you agree
to this License. This library is free software; you can redistribute it and/or modify it under
the
terms of the GNU Lesser General Public License as published by the Free Software
Foundation; either version 2.1 of the License, or (at your option) any later version. This
library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin St,
Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies.User
documentation of any code that uses this code or any modified version of this code must
cite the Copyright, this License, the Availability note, and "Used by permission."
Permission to modify the code and to distribute modified code is granted, provided the
Copyright, this License, and the Availability note are retained, and a notice that the code
was modified is included. Qt Availability: http://www.qtsoftware.com/downloads  Patches
Applied to Qt can be found in the installation at:
$HPEESOF_DIR/prod/licenses/thirdparty/qt/patches. You may also contact Brian
Buchanan at Agilent Inc. at brian_buchanan@agilent.com for more information.

The HiSIM_HV source code, and all copyrights, trade secrets or other intellectual property
rights in and to the source code, is owned by Hiroshima University and/or STARC.
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http://www.mathworks.com
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http://www.netlib.org
http://www.qtsoftware.com/downloads
http://www.qtsoftware.com/downloads


Advanced Design System 2011.01 - Windows Installation

5

Errata The ADS product may contain references to "HP" or "HPEESOF" such as in file
names and directory names. The business entity formerly known as "HP EEsof" is now part
of Agilent Technologies and is known as "Agilent EEsof". To avoid broken functionality and
to maintain backward compatibility for our customers, we did not change all the names
and labels that contain "HP" or "HPEESOF" references.

Warranty The material contained in this document is provided "as is", and is subject to
being changed, without notice, in future editions. Further, to the maximum extent
permitted by applicable law, Agilent disclaims all warranties, either express or implied,
with regard to this documentation and any information contained herein, including but not
limited to the implied warranties of merchantability and fitness for a particular purpose.
Agilent shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any
information contained herein. Should Agilent and the user have a separate written
agreement with warranty terms covering the material in this document that conflict with
these terms, the warranty terms in the separate agreement shall control.

Technology Licenses The hardware and/or software described in this document are
furnished under a license and may be used or copied only in accordance with the terms of
such license. Portions of this product include the SystemC software licensed under Open
Source terms, which are available for download at http://systemc.org/ . This software is
redistributed by Agilent. The Contributors of the SystemC software provide this software
"as is" and offer no warranty of any kind, express or implied, including without limitation
warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be
liable for any damages of any kind including without limitation direct, indirect, special,
incidental and consequential damages, such as lost profits. Any provisions that differ from
this disclaimer are offered by Agilent only.

Restricted Rights Legend U.S. Government Restricted Rights. Software and technical
data rights granted to the federal government include only those rights customarily
provided to end user customers. Agilent provides this customary commercial license in
Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212
(Computer Software) and, for the Department of Defense, DFARS 252.227-7015
(Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial
Computer Software or Computer Software Documentation).

http://systemc.org/
http://systemc.org/
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 Before You Begin Windows Installation
Before starting the Advanced Design System (ADS) Installation on Windows platform, you
must read the guidelines provided on this page.

 

 ADS Supported Platforms
ADS supports the following platforms:

OS 32 bit 64 bit

Windows/VISTA Microsoft Windows XP
Professional SP3
Microsoft Windows Vista
Enterprise SP1

Microsoft Windows XP Professional x64
Microsoft Windows Vista Enterprise SP1 64-bit edition

Windows 7 Microsoft Windows 7
Enterprise

Microsoft Windows 7 Enterprise 64-bit edition

LINUX Redhat RHEL WS 4.x and
RHEL 5
Novell SLES 9.x and SLES 10

Redhat RHEL WS 4.x and RHEL 5
Novell SLES 9.x and SLES 10 (64-bit AMD Opteron and Intel
EM64T processors)

Solaris (SPARC) Not Supported Solaris 10 with 64-bit support turned on Solaris 10 05/08
Patch Bundle
or the Solaris 10 05/08 (Update 5) release image with 138352-
02 X11 6.6.2: fontconfig patch

For updated list of supported platforms, refer to ADS Supported Platforms .

 
 

 Check the System Requirements
Ensure that your hardware and software configuration meets the following minimum
hardware and system requirements to install and/or run ADS.

Note
Agilent recommends you to have more than the minimum configuration to effectively work with ADS.

http://cp.literature.agilent.com/litweb/pdf/5990-3132EN.pdf
http://cp.literature.agilent.com/litweb/pdf/5990-3132EN.pdf
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Requirement Description

 32-bit Operating System
and Service Pack

Microsoft Windows XP Professional SP3
Microsoft Windows Vista Enterprise SP1
Microsoft Windows 7 Enterprise

64-bit Operating System Microsoft Windows XP Professional x64
Microsoft Windows Vista Enterprise SP1 64-bit edition
Microsoft Windows 7 Enterprise 64-bit edition

 Display High-resolution color only (Super VGA, 1024x768, 15-inch monitor minimum).

 RAM Minimum 1 GB RAM recommended for Windows XP
Minimum 4 GB RAM recommended for Windows Vista and Windows 7
On a 32-bit Windows XP operating system, its processes cannot use more than
2 GB of memory for a single simulation process regardless of the maximum
addressable memory available.

 Web Browser Microsoft Internet Explorer version 5.5 or higher
Mozilla Firefox 3.3 or higher
Acrobat Reader 5.0 or higher (to view PDF files).
Java and JavaScript must be enabled on your browser for the documentation to
appear correctly. Java Runtime Environment (JRE) must be installed on your
machine to use the search functionality provided in the ADS documentation. The
minimum recommended version is Sun Java Plug-in 1.3. See Verifying Java
(JRE) Installation in Windows to check if JRE is installed or not.

 Hard Disk 4.5 GB for a complete installation. Recommended file system is NTFS. Novell file
servers are not supported. VFAT/FAT systems are not recommended for
complete installations.

 Security Device ADS software licenses are locked to an external device (FLEXid hardware
security key) attached to the PC's USB or parallel port or locked to a PC's LAN
ethernet card. Licenses can also be secured to a network server using FLEXlm
server software.

 Supported Printers Printers supported by the operating system used.

Internet Access High speed internet access is required to download the ADS install file.

Processor Intel Pentium © 4 or higher, or AMD XP 3000 or higher.

 Compiler (only for model
development and 64-bit
simulations involving
Verilog-A components)

C++ and C:
Microsoft Visual Studio .NET 2008 with SP1/Hotfix (Windows Vista 64 also
requires Microsoft Visual Studio 2008 Team Suite Service Pack 1 and Visual
Studio 2008 Service Pack 1 Update for Windows Vista)

  HDL simulator
(required only for HDL
cosimulation)

Only Mentor Graphics ModelSim SE Plus 6.3a is supported in 32-bit mode.

 

 ADS Installation options
ADS supports Complete as well Custom installation of the software.

 

 Complete Installation Options

If you select Complete install, ADS installs the following for which you need at least 4.5
GB of free disk space:
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Features Description

ADS programs and tools This is the basic ADS software and necessary tools to run ADS.

DesignGuides and Application
Guides

Special interactive tool kits and handbooks for various design types

Manuals & Help All documentation. If this option is not selected, documentation will not be
available

Examples All examples for Advanced Design System

 

 Custom Installation Options

If you opt for Custom Install, you can select the ADS features you want to install. The
following table lists the supported features:

Features Description

ADS programs and tools This is the basic ADS software, minus the following features

DesignGuides and Application
Guides

Special interactive tool kits and handbooks for various design types

Manuals & Help All documentation. If this option is not selected, documentation will not be
available

Examples All examples for Advanced Design System

 User Compiled Models
If you are using dynamic User Compile Models (UCM) and upgrading from earlier ADS
release, recompilation is required only if the compiler has been upgraded. For example, if
you are doing 32-bit models, going from 2009 Update 1 to 2011.01, the compiler was
upgraded so recompilation is required.

For static UCM, recompilation is required for every upgrade.

 
 
 

 Obtain ADS 2011.01 Licenses
 Though you can install all ADS features but you can use only those for which you have a
valid licenses. To obtain license, you can submit online request at License Request Form  .
The licenses are then emailed to you in a license file, file with extension .lic, for example
license.lic. You can also tie your licenses to a hardware key or dongle. To obtain a valid
hardware key, contact Agilent EEsof Business Support.

For details on how to setup your ADS license, see Installing Your Licenses (instalpc).

 Multiple ADS Installations
You can have multiple installations of ADS in separate directories on the same machine,

http://www.agilent.com/find/agilent-software-manager
http://www.agilent.com/find/agilent-software-manager
http://www.agilent.com/find/agilent-software-manager
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but you cannot install the current version over a previous ADS installation, a Previous
Version Detected error message is displayed. This is also applicable for Early Access
versions of ADS.

Before uninstalling or deleting previous ADS installation:

Keep a copy of your workspaces, customized configuration files, and other data.
Keep a copy of your license file available in <install_directory>\licenses folder.

For details on running multiple ADS versions, refer to Using Multiple ADS Versions
(instalpc).

  

 Check Available Memory

 RAM

You need a minimum of 1 GB RAM on your system. More memory results in better overall
system performance for some design work. However, since ADS is compiled on a 32-bit
operating system, its processes cannot use more than 2 GB regardless of the maximum
addressable memory available on your system. To check the amount of memory on your
system without rebooting, double-click the My Computer icon. From My Computer
window, choose Help > About Windows and available physical memory is displayed in
About Windows.

  

 Disk Space

For complete ADS installation, you need 4.5 GB of disk space. For custom installation, the
amount of disk space required depends on the ADS features that you want to install. As
you run the ADS installation program, the disk space required for various features is also
indicated.

Note
You need extra temporary space of up to 1.75 GB for self extracting installation file.

To check the free disk space available on your system, double-click the My Computer
icon. Select View > Details. Look in the Free Space (displayed in left column) for each
of your drives where you want to install ADS.
 

 Defining an Install Folder
The default folder for ADS installation is "C:\agilent\". You can change the default
location and select your own desired path. Ensure that you must have permissions to write
to the disk drive on which you want to install ADS. The installation also adds entries to
your PC's Windows Registry so ensure that you have permissions to do so.
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Note
The installation path and folder name for ADS software should be without any spaces as ADS may give
error while executing simulation.

For more details, see Installing Advanced Design System on Windows (instalpc).

 Supported Features on Windows 64-bit
The following simulators are supported when ADS is installed on a Windows XP
Professional x64 or Windows Vista 64-bit operating system:

 64-bit  Analog/RF
64-bit  Momentum
64-bit  ADS Ptolemy

If you want to run these simulators in 32-bit mode or you want to use features that are
not available on a 64-bit operating system, you can launch ADS in 32-bit mode. See
Running Advanced Design System (instalpc).

The following tables provide details about the supported features when ADS is installed on
a Windows XP Professional x64 or Windows Vista 64-bit operating system.

Functionality Windows 64-bit

Large Schematics, Netlists, Layouts 32-bit mode

Data Display / Large Datasets native 64-bit

3rd Party: DRC, Translators 32-bit mode

Utilities (LineCalc, Smith, DesignGuides) 32-bit mode

Connection Manager Client 32-bit mode

Connection Manager Server n/a

Legacy Instrument Server n/a

Dynamic Link to Cadence n/a

FlexLM License Server native 64-bit

Circuit Simulation Windows 64-bit

Circuit Simulation Engine, Local Simulation (assume no
external cosims or linked executables)

native 64-bit

Circuit Simulation Engine, Remote Simulation (assume no
external cosims or linked executables)

native 64-bit

Verilog-A all native 64-bit only, or all 32-
bit compatibility mode, no 64/32-bit mixture

User-Compiled Models, SimKit, MINT all native 64-bit only, or all 32-
bit compatibility mode, no 64/32-bit mixture

LSF Support n/a

A/RF Modulated-Source-DSP-Based 32-bit mode

A/RF, MeasEqn Expressions based on ADS Ptolemy
(evm_wlan_dsss_cck_pbcc(), evm_wlan_ofdm(),
spectrum_analyzer())

32-bit mode

A/RF Wireless Test Benches (assume no 3rd party cosims) 32-bit mode

System Simulation Windows 64-bit
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 Ptolemy Engine (assume no user-compiled models) native 64-bit

Ptolemy Remote Simulation native 64-bit

Ptolemy, Connection Manager Instruments components (except
for links listed below)

native 64-bit

Signal Studio file reader and writer (CM_SStudioFileRead, or
'write_to_datafile' feature in the CM_ESG_*_Sink components)

native 64-bit

Ptolemy, User-Compiled C all native 64-bit only, or all 32-
bit compatibility mode, no 64/32-bit mixture

Matlab Cosim ADS and MATLAB with both native 64-bit
only, or both 32-bit compatibility mode, no
64/32-bit mixture

HDL Cosim both ADS and HDL simulator must be
running under 32-bit compatibility mode

SystemC Cosim 32-bit mode

Ptolemy, Interactive Controls and Displays Components native 64-bit

VeeLink n/a

CM_LA_167xx_Source component n/a

VSA 89600 components (VSA_89600_1_Sink,
VSA_89600_1_Source, VSA_89600_2_Sink, VSA_89600_Sink,
VSA_89600_Source)

n/a

Momentum Simulation Windows 64-bit

Momentum Engine, Local native 64-bit

Momentum Engine, Remote Simulation native 64-bit

Momentum Visualization (and 3D Layout Viewer) native 64-bit

Note
All Connection Manager Client and Instrument components require that the Connection Manager Server be
installed on the same machine or on a remote Windows 32-bit XP or 2000 machine.

 Verifying Java (JRE) Installation in Windows
JRE must be installed in for help search engine to work effectively. Follow the steps below
to verify whether JRE is installed on your PC or not:

From desktop, choose Start > Control Panel to open the Control Panel window.
If you see the coffee cup icon (see figure below) in the Control Panel window, it
confirms that JRE is installed on your computer.
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Note
You can download and install the JRE in your computer, from the url:
http://java.com/java/download/index.jsp

   

http://java.com/java/download/index.jsp
http://java.com/java/download/index.jsp
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 Installing Advanced Design System on
Windows
Before starting ADS installation on a Windows platform, see Before You Begin Windows
Installation (instalpc) for system requirements and other necessary details.

Note
If you have installed an Early Access version of ADS, you should uninstall it before installing this version.
For more information, see Uninstalling Advanced Design System.

 Installing ADS on a System
Follow the steps below to install ADS on your system running on Windows platform:

Download the ADS installation file ads2011_01_rXXX_windows.exe from the Agilent1.
EEsof EDA Web  to any folder, say C:\Temp.
Run the self extracting installation file ads2011_01_rXXX_windows.exe from the2.
location where you saved it.

Note
Before starting the installation, the installation file extracts all the necessary files in a temporary
folder.

Select the language from the drop-down list of Installation window and click OK to3.
continue.
At the Introduction screen, click Next to read the License Agreement. This is only a4.
usage agreement and is not related to the licenses required to run the software.
At the License Agreement screen, accept the agreement and click Next to continue5.
with setup.
At the Choose Install Set screen, choose any one of the two installation options:6.

Complete: For complete ADS installation. It requires about 4.5 GB of disk space
and installs the ADS design environment, simulators, documentation, examples,
and DesignGuides. If you choose a Complete installation, skip the next step.
Custom: For customized installation where you can choose from the ADS items
you want to install. For a list of custom installation items, see Installation Items.

Note
While you can choose which ADS items you want to install, the ability to run them is
determined by the licenses you have purchased.

For a custom installation, the next screen lets you choose the items you want to7.
install. Click any item name to see the description of the same in the window below.
Select the items you want to install and click Next to continue.

Note
You must choose to install ADS programs and tools which includes Layout, Simulators and
Schematic Capture; otherwise ADS will not run properly.
Manuals & Help is selected by default to install the entire ADS documentation set. If you uncheck
this item, documentation and help files will not be available regardless of which other items you
choose.

At the Choose Install Folder screen, click:8.
Next to install to the default folder. The installation program will create this

http://www.agilent.com/find/eesof-ads-latest-downloads
http://www.agilent.com/find/eesof-ads-latest-downloads
http://www.agilent.com/find/eesof-ads-latest-downloads
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folder if it does not already exist. One more option Restore Default Folder is
also provided to restore the default folder after every uninstallation.
Choose to specify a different destination folder. If you specify a folder that does
not already exist, the installation program will create it for you.

At the Set Your Home Directory screen, click:9.
Next to accept the default.
Choose to select a different folder.
The folder you specify will be the default startup folder for ADS. It will also be
used to store the configuration data in a subfolder called hpeesof.

Note
If you are using more than one ADS version, choose a new Home folder for each version. For
the best performance, choose a folder on your local, not network, drive.

At the Choose Shortcut Folder screen:10.
You can type a name in Start Menu Folder Name to have the same named folder
in Start menu,by default it is Advanced Design Systems 2011.01.
If you want ADS icon on desktop, check the Icon To Desktop option.

At the Pre-Installation Summary screen, review your choices, and click:11.
Previous to access previous screens to verify entries and make changes. This
screen appears again if you go back to make other choices.
Install to start the installation. Immediately after you click Next, the Setup
Status screen appears and the program configures the installation process.
When the program determines that your system is ready for installation, it
begins to install files. The status screen displays the files being installed and the
progress.
Cancel to exit the Setup without completing the installation.

After installation, click Done to quit the installer. The ADS License Setup Wizard12.
starts automatically after this and check for the license status. Before launching ADS,
you must complete the ADS license setup. For more details on license setup
instructions, see Windows License Setup (instalpc).

    

 Installation Items

A complete ADS installation installs these items except FLEXnet files and requires
approximately 4.5 GB of disk space. For a custom installation, you can choose which items
you want to install.

Item Description

ADS Programs and
Tools

This is the basic ADS software, including the Design Environment, Data Display,
simulators for analog/RF systems, signal processing and electromagnetic designs.

DesignGuides and
Application Guides

Special interactive tool kits and handbooks for various design types.

FLEXnet Files FLEXnet licensing software

Manuals and Help Online documentation, help, and search engine. Documentation and help files will not be
available if this option is not selected. ADS uses HTML-based documentation displayed
using your Web browser. See Check the System Requirements (instalpc) for browser
requirements.

Examples Complete ADS application examples with search engine.
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 Installing ADS on the Server
To install ADS on the server, ensure that the LAN client files are part of the installation.
ADS installs a folder, LAN_client_setup, under the <ADS Installation folder> (for
example: C:\<ADS installation folder>\LAN_client_setup) with the files required to
set up client machines.

Once the server installation is complete, share the installation directory so that client
machines can access the software across the network. Consult your system administrator
or refer to your Windows documentation for instructions on sharing directories.

 Using the LAN Client Installation Process

Once you have installed ADS on a server and shared the installation folder, use the
following steps to install clients on each client machine.

Notes

You need to uninstall any local ADS installation from a machine before you start the LAN Client1.
setup process on it. See Uninstalling Advanced Design System for uninstall instructions.
LAN or Client PC installation problems can occur if you access server files using a UNC path, or a2.
path such as \\hostname\share. This path can come about if you use the Network Neighborhood to
attach to server files, where you assign a drive letter to it; or if you use the Windows Explorer with
the \\hostname\share notation to access a shared drive.

Map a drive on the client machine that connects to the shared ADS installation1.
directory from the server machine. For example, you may create a mapped drive G:
that accesses the C:\<ADS installation folder> directory on the server. Consult
your system administrator or refer to your Windows documentation for instructions
on mapping paths.
Run setup.exe from the LAN_client_setup folder to start the Install Shield wizard.2.
The Advanced Design System 2011.01 LAN Client Installation title window appears3.
displaying the Welcome screen. Click Next to view the License Agreement.
At the License Agreement screen, click Yes to accept the License Agreement and4.
continue with the setup.
At the Specify Your Home Directory screen, define the install destination for the5.
client's program files. Click Browse to change the default folder.
Click Next to continue.6.
At the Personal or Common program folder screen:7.
Choose an option either Create folder and shortcuts only for current user OR Create8.
folder and shortcuts for all users and click Next.
At the Select Program Folder screen, enter the Program Folder name. You can type a9.
new folder or select one from the Existing Folders list to select the Program folder.
At the Check Setup Information screen, review your choices and click:10.

Back to access previous screens to verify entries and make changes. This1.
screen appears again if you go back to make other choices.
Next to continue the installation.2.
Cancel to exit the LAN Setup without completing the client installation.3.
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When the installation is complete, click Finish.11.

 Running Silent LAN Client Installations

To run the silent LAN client installation, follow the steps below:

On a single system, you can record a sample response file to be used on other1.
systems. Run the sample interactive installation with the  -r "filename" arguments.
The following is an example of a command to run under the LAN_client_setup sub
folder or the server installation of Advanced Design System (change c:\tmp reference
to a directory available on your system, using two backslashes in the path ):
setup /r /f1"c:\tmp\lanc.iss"

Add the setting INSTALLER_UI=silent near the top of the recorded file to enable2.
silent mode.
On other systems, you can use this response file to run a silent installation by using3.
the  -f "filename" arguments, under the following, the start /wait part of the
command is not required, it just lets you know when the command has finished.

start /wait setup.exe  -f c:\tmp\lanc.iss

If there's a need to customize setting on a per client basis, you need to edit the response
file before you run the silent installation.

The USER_INSTALL_DIR directory is set to directory where the original version of
ADS is installed, for example

USER_INSTALL_DIR=t:\\servershare\\Agilent\\ADS2011_01

The HOME directory is set through the variable USER_SELECTED_FOLDER, for
example:

USER_SELECTED_FOLDER=C:\\users\\default

The name of the Start Menu folder is set through the variable szFolder, for example:

USER_STARTMENU_FOLDER=Advanced Design System 2011.01

Example lanc.iss file

# Mon Jan 24 11:34:41 PST 2011

# Replay feature output

#---------------------

# This file was built by the Replay feature of InstallAnywhere.

# It contains variables that were set by Panels, Consoles or Custom Code.

INSTALLER_UI=silent

#Choose Advanced Design System File Server Folder

#------------------------------------------------

USER_INSTALL_DIR=Y:\\FileServer\\Agilent\\ADS2011_01

#Set Your Home Directory

#----------------------
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USER_SELECTED_FOLDER=C:\\Users\\yourname

#Set Your EEsof License Tools Directory

#--------------------------------------

HPEESOF_LIC_INSTDIR=C:\\Program Files\\Agilen\\EEsof_License_Tools

#Choose Shortcut Folder

#----------------------

USER_STARTMENU_FOLDER=Advanced Design System 2011.01 - Lan Client Installation

ICONS_TO_DESKTOP=1

 Using Batch Files to set up ADS Clients

 
Client installations of ADS can also be set up to run using batch (.bat) files. Use the
following information to set up your batch files if you choose to run ADS using this option.

Note
Running ADS clients using a batch file is optional. If you do not intend to use batch files, skip the next two
sections on Configuring ADS for Batch-Mode Clients and Creating a Batch File to run ADS Clients.

Once you have installed ADS on a server and shared the installation folder, complete the
following two steps to install clients on each client machine.

You can install ADS on your network and run it from any PC connected to your network.

Install ADS selecting the Complete installation option on at least one PC (the file1.
server). If you are a new user of ADS 2011, you will be asked to set your EEsof
license tools directory. Select a direct residing on the file server or copy the contents
of this directory to the file server after you have installed ADS.
Share the Advanced Design System installation directory and the EEsof License Tools2.
directory with the users on your network.   If you are a new user of ADS 2011, you
need to share an EEsof License Tools directory to all your users and if you support
the use of a batch file, set an environment variable HPEEOSF_LIC_DIR to this path
under the batch file.

 Configuring ADS for Batch-Mode Clients

On each client system, you have to run a small setup.exe configuration program just once
per system. For more details, see Running the Configuration Script (instalpc).

The following is an example of an error message you see if you use a batch file against a
network copy of ADS and you have not run the required setup.exe configuration program
on the client system.

< prompt > .\ads.exe  The application has failed to start

because its side-by-side configuration is incorrect.

See the application event log for more detail.

 Creating a Batch File to run ADS Clients

Using a text editor, create a batch file on the client system(s). The name of this file is not
as important as giving it the .bat file extension. The file can be located anywhere on the
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client system. You can create a Windows shortcut to the batch file for added convenience.

For more details on how to create a batch file, see Creating a Batch File to Set the
Environment and Start ADS (instalpc).

 Installing from a File Server
 
The contents of the downloaded installation image of ADS can be copied to a file server PC
enabling you to install ADS from this file server. This arrangement is useful for doing silent
installations (see Silent Installations).
Ensure that you must have read and write permissions to install ADS from a File
Server.Follow the same steps for installation as defined in Installing Advanced Design
System on Windows (instalpc)

 Using Multiple ADS Versions
 
Use the following instructions to maintain and run more than one version of ADS (such as
version 2009U1 and 2011.01). Keep a separate $HOME directory for each version of ADS
to help in structuring all the files and to avoid problems that may arise due to sharing of
the configuration files among multiple installations.

 

 Setting the HOME Directory

 
Follow the steps below to specify the $HOME variable value in the registry for each version
of ADS.

Click Start > Run.1.
Type regedit in the Run box and click OK.2.
In the Registry Editor, select HKEY_LOCAL_MACHINE > SOFTWARE > agilent >3.
ADS > ( ADS version ) > eeenv.
Select HOME and choose Edit > Modify to enter the desired location and click OK to4.
apply the changes.
Close the Registry Editor.5.

Repeat these steps for each version of ADS.

Caution
Use extreme care when editing the system registry. The computer may not function properly if the
registry contains an error. You should backup the registry as a precaution. For more information, see the
Registry Editor's online Help.

 
 

 Setting the HOME Environment Variable
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Alternatively, you can set the $HOME variable as an environment variable. In this case,
you need to set it up in an MS-DOS batch script and run that batch script to start ADS.

Note
If you install ADS using a non-standard method and use an MS-DOS batch script to start ADS, you cannot
install off-cycle products ( addons,  hotfixes,  MSRs). To install off-cycle products, you must have a valid
ADS installation with standard registry entries.

 

 Script for ADS 2011.01

Choose the ADS version by running the appropriate script. Ensure that the Start in
variable is set correctly on the desktop shortcut by following the steps below:

Right-click the desktop shortcut that you use to start ADS.1.
Click Properties.2.
Click the Shortcut tab.3.
Verify that the Start in value is the same as the $HOME variable setting.4.

 

 Silent Installations
 The InstallAnywhere program provided with ADS supports a silent installation mode. A
normal (non-silent) installation receives the necessary input from the user installing the
software in the form of responses to prompts in dialog boxes. However, a silent
installation does not display prompts for inputs. InstallAnywhere supports a silent mode
that has no end-user interaction, and runs either using the defaults provided for a
complete install or using a response file that contains the values for various
InstallAnywhere variables, which control the installation. For details of response files, refer
Creating Your Own Response File.

 

 Silent Installation Overview

Here is an overview on how to set up and run a silent installation on a Windows PC.

On a server PC's sharable hard disk, copy the ADS install file in a folder. For details1.
about setting up a file server,refer Installing from a File Server.
Share this folder and map the folder to a client machine.2.
If needed, run a silent uninstallation before hand to remove ADS from the client PCs.3.
On client PCs, run the ads2011_01_rXXX_windows.exe using arguments for a silent4.
installation (see below).

 

 Running a Silent Installation
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 To run a silent installation on a client PC, run the setup.exe utility using the silent
installation arguments shown below:

On the client PC, verify that ADS installation folder does not already exist. There1.
should not be a C:\<ADS installation folder> folder since the silent installation
process is not expecting it to be there. If ADS has been installed, uninstall it using
instructions on Uninstalling Advanced Design System.
On the client PC, open a Command Prompt or DOS prompt window. In a command2.
prompt, change to the folder D:\<ADS installation folder>\dvd that is shared by the
server PC.
On the client PCs, perform one of the following actions to run a silent installation of3.
ADS:

Note
When a silent installation is running you won't see any confirmation that the installer is
running. However, the process monitor shows ads_install.exe processes running in the
background.
The most effective way to troubleshoot errors with the silent install/uninstall process is to run
the same type of installation in normal or visual mode.

Complete Silent Install
To perfrom a complete silent installation without requiring any user interaction,
type the following command from the command line:
ads2011_01_rXXX_windows.exe -i silent

Custom Silent Install
The custom silent installation gets its input from the response file
installvariables.properties created during a custom installation. To perform a
custom silent installation without requiring any user interaction, create a
response file then type the following command from the command line
specifying the path to the response file:
ads2011_01_rXXX_windows.exe -f c:\tmp\your_response_file.txt -i silent

To run the silent install and wait until the process finishes, change directory to
the Windows\Disk1\InstData\VM sub directory and run the ads_install.exe
executable, for example:
cd /d Windows\Disk1\InstData\VM
start /wait ads_install.exe -f c:\tmp\your_response_file.txt -i silent  

 Creating Your Own Response File

 
A response file is required to perform silent installation. During normal installation, inputs
provided manually into dialog boxes are automatically recorded to a response file. By
default, all of the variables defined in your installation are recorded. A response file is
always generated after the successful completion of an installation. InstallAnywhere
creates this file when the installation exits, storing the values of the applicable properties
in the file. This is useful for saving a record of a specific installation execution session that
can later be reused in a silent or custom installation.

This response file is a plain text file that uses a simple key=value format. If you want to
change the settings in a particular response file, you can edit the response file directly or
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create your own response file.

Example File:

INSTALLER_UI=silent

USER_INSTALL_DIR=C\:\\ADS2011_01

CHOSEN_INSTALL_SET=complete

USER_SELECTED_FOLDER=C\:\\users\\default

USER_DEFAULT_HOME=users\\default

USER_HOME_FOLDER=C\:\\users\\default

CHOSEN_INSTALL_FEATURE_LIST=ADS,DGS,Examples,Manuals

INSTALLER_UI allows you to specify the installer mode in the properties file, negating
the need to use the -i silent command-line switch.
USER_INSTALL_DIR is the location where you want to install ADS.
USER_DEFAULT_HOME is the location where you want to save your configuration files
and workspaces.
CHOSEN_INSTALL_SET can be set to a value of either "complete" or "custom".
If you set it to "complete", you don't need to add the
CHOSEN_INSTALL_FEATURE_LIST variable. The "complete" selection installs all of
the ADS modules.
If you select "custom", you need to set the CHOSEN_INSTALL_FEATURE_LIST (as
described below).
CHOSEN_INSTALL_FEATURE_LIST use one or more of the following items separated
by commas:
ADS, DGS, FLEXnet, Manuals, Examples
CHOSEN_INSTALL_FEATURE_LIST (items) Description

ADS ADS programs and tools

DGS DesignGuides and Application Guides

FLEXnet FLEXnet Files (licensing software for license
servers)

Manuals Manuals & Help

Examples Examples

Installing all these features constitutes a complete install.
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 Before Setting Up Licenses For
Windows
This section provides information about the prerequisites for setting up licenses on
Windows.

 

 Obtaining a HostId/Hardware Key
If you are using dongle, you must have the hardware key. In the absence of a hardware
key, you need to obtain the Host Id of your machine. Host Id is the physical address
displayed on the LAN adapter of your machine.

To obtain the Host Id (Ethernet Address / License Id):

Select Start > Run and enter the following command:1.
cmd /k ipconfig /all

Click OK to open the cmd window.2.

For example:

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix . . . . . . . . . . your_network.com.

Description . . . . . . . . . . . . . . . . . . Broadcom NetXtreme Gigabit Ethernet

Physical Address . . . . . . . . . . . . . . . . . . . . . *00-08-05-E1-A8-DF*

Notes

The 12-digit Host Id/Physical Address should be used without dashes, for example, 000805E1A8DF.
This example applies to LAN card users. Wireless Network Card users should locate their network
card in the text file and use that Physical Address.

 

 Obtaining the ADS License File
You must have a license file (file with extension .lic) before starting ADS license setup. If
you have not received the same, you can place your ADS license request for:

New Sale License Request
New Release License Request
Renew Expired License
Early Access License Request
Change / Transfer Licenses
Evaluation License / Token Redemption / Renewal Request
Temporary / Provisional License Request

 Evaluation License
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If your request for ADS evaluation license is approved, you will receive a license file (of
ADS license version 2.9) as an attachment through e-mail. Save this license file on your
computer.

Click here  to order ADS evaluation / trial version.

 Purchased License

If you purchase the ADS license, you will receive an e-mail containing an entitlement
certificate. Follow the instructions in e-mail that directs you to the Agilent Software
Manager (ASM) to redeem the certificate for a license file. The license file will be sent
through e-mail. You can also download the license file from the Agilent website. Save the
license file on your computer.

 

 License Types
ADS supports the following license types:

Floating: This license type is used to run license server to cater the licenses to the
remote machines.For example:

SERVER cinnamon 0025B3A05E6F

VENDOR agileesofd

INCREMENT b_core agileesofd 2.9 23-nov-2010 1 \

VENDOR_STRING="0025B3A05E6FP=#1,7,8,13,14,25,27,66,67,105,110,116,131,132,156D=#W2200BT,ADS_

Core;e_core \

               : RUIGYQG 2UIWQDI PYPNDAX NCJLZW2 TFGCOWK GNIX" \

               START=25-oct-2010 SIGN="0313 D7B4 40BF 7578 AF7F 8DF4 A4C4 \

               0DA1 67C9 3FFE 2103 2AB0 0F1F BDFA 4F7D 67FB 2CD2 FC3F 24B7 \

               6E95 D4FB"

Node Locked: This license type is used for accessing ADS on current machine. For
example:

SERVER madhubs 0025B3A05E6F

VENDOR agileesofd

INCREMENT b_core agileesofd 2.9 23-nov-2010 1 \

VENDOR_STRING="0025B3A05E6FP=#1,7,8,13,14,25,27,66,67,105,110,116,131,132,156D=#W2200BT,ADS_

Core;e_core \

               : RUIGYQG 2UIWQDI PYPNDAX NCJLZW2 TFGCOWK GNIX" \

               HOSTID=0025b3a05e6f START=25-oct-2010 SIGN="02D8 82B1 95BC \

               19B1 A3F8 33E6 D7C2 8AF3 6DCF 8A4C 3000 7F98 51BE 5973 C6CB \

               3569 21FA 0DB9 B030 660F 59BE"

The single user license allows only one simultaneous simulation, which is of the same type.

https://edasupportweb.soco.agilent.com/license/faces/licensehome.jsp
https://edasupportweb.soco.agilent.com/license/faces/licensehome.jsp
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 License Codewords
For an updated list of supported license codewords, visit Agilent EEsof website .

http://www.agilent.com/find/eesof-license-dependencies
http://www.agilent.com/find/eesof-license-dependencies
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 Windows License Setup
After installing Advanced Design System (ADS), you need to setup your ADS license
before running ADS. This section provides license setup information on a Windows
platform.

Note
The ADS License Setup Wizard starts automatically once ADS is installed successfully. If you have
already received your license file (file with extension .lic), then you can also setup your ADS license
using License Setup wizard. For more details on setting up license through wizard, see License Setup
through Wizard.

  

 License Setup Flow
The following flowchart illustrates the steps that you can refer for completing the ADS
license setup (without using ADS License Setup Wizard).

 
 
 

 Get Host Id
To obtain a host ID of your machine, see Obtain Host Id (instalpc).

 Installing a Hardware Key

 
If you are using a hardware key for ADS license, run FLEXnet to install the FLEXid
hardware key (also called a dongle) on a parallel or USB port of your computer. In a node-
locked environment, the hardware key is installed on the local machine. In a floating
license environment, it is only required on the server machine.
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Notes

Before installing the hardware key, note the hardware key ID number. If you have not received your1.
security licenses from Agilent EEsof, you will need to provide this number for your License Request
Form, as explained in the section, License Types (instalpc).
ADS 2011.01 installs version 11.9.0.0 of FLEXnet. Make sure you use the latest version of the2.
FLEXnet software, drivers, and hardware key as needed on all ADS systems and license servers.

  

 Installing the FLEXid Driver

You can lock your license to a hardware key. For this, you must have the system
administrative privileges. The ADS installation file also installs the Flexid driver, in case
there are any issues you can reinstall the same by following the steps below:

Run FLEXId_Dongle_Driver_Installer.exe file from C:\Program
1.

Files\Agilent\EEsof_License_Tools\bin folder to start the FLEXid Dongle Driver
Installer Wizard.
Select the drivers you want to uninstall and click Next.2.
After successful installation, click Finish to terminate the wizard.3.
Restart your computer to activate the installed driver.4.

Note
To remove any existing FLEXid drivers run FLEXid_Dongle_Driver_Installer/remove.

 

 Using the Ethernet Address of the PC LAN Card

 
Another way to run the FLEXnet licensing system on your PC is to read your LAN card's
Ethernet address and have Agilent EEsof Business Support tie this identifier to your ADS
licenses. To obtain Ethernet address:

Ensure that you have TCP/IP and IPX/SPX network protocols loaded on your PC. The1.
IPX/SPX protocol is required by FLEXnet.
Verify that you can read your LAN card's Ethernet address (also known as the2.
"physical address"). For all versions of Windows, run the following FLEXnet command
from the MS DOS Command Prompt:

C:\Program Files\Agilent\EEsof_License_Tools\bin

lmutil lmhostid

Note
If lmutil lmhostid command does not return the expected address, make sure you have the
IPX/SPX (NWLink IPX/SPX Compatible Transport) protocol loaded.
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 Obtain License File
You must have a valid license file to start the license setup. Click here  to order ADS
evaluation/trial version. Once your license request is approved, license file is mailed as an
attachment to registered email id.

You can also contact Agilent EEsof business support for license file.

 
 

 License Setup
The following section provide instructions to install ADS license. You should have installed
ADS before you complete these steps. For details on installing ADS on a PC running
Windows, refer to Installing Advanced Design System (instalpc).

Notes

Use the following information to update all existing license servers with the latest version of the1.
FLEXnet software (e.g., lmgrd and lmutil). The software is installed with ADS 2011.01. Using older
versions may cause license-encryption errors, invalid hostid results, and unsupported feature errors.
Verify that all multiple and redundant servers are updated including any license administration2.
scripts in use. Run lmutil from the C:\Program Files\Agilent\EEsof_License_Tools\bin for
information to help modify the scripts.
Restart the license server.3.

 

 Installing the License File

 The license.lic file that implements FLEXnet security must be installed to run ADS.
Save the license file,license.lic, file that you received via e-mail to a folder, for
example, C:\Program Files\Agilent\EEsof_License_Tools\licenses. .

If your licenses will be served by a central server, have your system administrator install
the license.lic file on the license server machine.

 

 Customizing Your License File (optional)

It is recommended that you use the license file you receive without modifying its content.
Starting with ADS 2011.01, all license.lic files are generated with SERVER lines with the
following format:

SERVER this_host <hostid>

where:

https://edasupportweb.soco.agilent.com/license/faces/licensehome.jsp
https://edasupportweb.soco.agilent.com/license/faces/licensehome.jsp
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this_host is equivalent to the hostname of the system that the license server is
running on
<hostid> is the License ID (FLEXID hardware key number or Ethernet address)
of the license server.

If you wish to modify the license file you can change the default hostname setting in your
license file to the actual hostname of the license server system. The license server is the
machine that will serve the licenses on the network, and whose Ethernet address or
FLEXID hardware key number, appears on the SERVER line.

For example, assuming that a machine with FLEXID hardware key number 8-
5E700059B957 has a hostname of joshua. The SERVER line should read:

SERVER joshua FLEXID=8-5E700059B957

For example:

SERVER joshua FLEXID=8-5E700059B957 27000

You can also specify a specific TCP port number for license requests as follows:

SERVER <hostname> <hostid> <tcp_port>

If you do not specify a TCP port number on the SERVER line, the license server will use
the first available TCP port number in the range 27000 to 27009.

If you do not use the license setup wizard to install your licenses then you will need to set
the ADS_LICENSE_FILE as follows.

ADS_LICENSE_FILE=@joshua

Note
Enter a specific port address on the SERVER line for improved license check-out performance. You may
enter a port address outside the range of 27000 to 27009, as long as the address is not used elsewhere.
Then set the environment variable ADS_LICENSE_FILE.

 

 Setting the Vendor Daemon Path

 By default, no path is specified for the agileesofd vendor daemon executable. This is
acceptable as long as lmgrd and agileesofd are in the same folder when you start
FLEXlmgrd.

In the typical license configuration, lmgrd and agileesofd are both located in the
C:\program Files\agilent\EEsof_License_Tools\bin folder. After lmgrd is started, it
searches for agileesofd in the same folder. If agileesofd is not in the same folder as
lmgrd, you must specify a path to it using the following syntax

VENDOR agileesofd C:\Program
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Files\Agilent\EEsof_License_Tools\bin\agileesofd

  

 Connecting to a License Server through a Firewall

If client systems connect to a license server through an Internet firewall set up on a
Windows PC, you must also specify the port number the vendor daemon uses. You can
specify the port number on the license file's VENDOR line. If the port is not specified, the
default is chosen by the operating system at run time. If this port number is specified,
there may be a delay restarting the vendor daemon until all clients have closed their
connections to the daemon. Here is an example of a properly configured VENDOR line
including the daemon path and port number:

VENDOR agileesofd C:\Program

Files\Agilent\EEsof_License_Tools\bin\agileesofd` 1705

Some clients may timeout before they can connect to a license server through a firewall.
The default timeout period is 0.1 second. If you need a longer timeout period, you can set
the environment variable FLEXLM_TIMEOUT to a new value. Enter the value using
microseconds. Agilent EEsof recommends trying one second. For example:

 FLEXLM_TIMEOUT=1000000

Depending on your network, you may need to adjust the period so it is long enough to
allow connections without slowing down simulations excessively.

 

 Starting Server

 Server can be started using FLEXlmgrd. You must start the FLEXnet license manager
daemon (lmgrd) on the license server(s) first. Once the license server(s) is running lmgrd
and has started the vendor daemon(s), you can configure the other machines (clients)
and user login accounts that need to access ADS.

To start server you need the following:

FLEXnet software installed in the C:\Program
Files\Agilent\EEsof_License_Tools\bin folder. This is done when you install ADS.
The license server machine connected to the network using the TCP/IP network
protocol.
A local copy of the license.lic file that contains the FLEXnet licenses. Every
machine that will run ADS must be able to access the license.lic file used by the
license server(s) to check out a license. Access to the license.lic file can be via a local
copy of the license.lic file or through a network drive.
Properly configured SERVER and VENDOR lines in your license.lic file.

If you have a three-server redundant configuration, you must start FLEXnet on all three
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servers before the licenses will be available on the network. Once you have FLEXnet
running, you can configure the other machines (clients) and user login accounts that need
to access ADS by setting the ADS_LICENSE_FILE.

 
 Use the following steps to start the FLEXnet executable file, lmgrd.exe:

From a MS-DOS Command Prompt, change the following:1.
C:\Program Files\Agilent\EEsof_License_Tools\bin

Type the following command specifying the full path and location of the license file:2.
lmgrd -c C:\Program Files\Agilent\EEsof_License_Tools\licenses\license.lic

-l C:\Program Files\Agilent\EEsof_License_Tools\flex.log

To shut down the license manager, enter the following at a command prompt, from the
C:\Program Files\Agilent\EEsof_License_Tools\bin folder:

lmutil lmdown -c C:\Program

Files\Agilent\EEsof_License_Tools\licenses\license.lic

 

 Ensuring Access to the License File

 You need to configure each client machine to access the license server and to check out a
license. You can do this by using one of two methods:

Place a copy of the license.lic file in the C:\Program
Files\Agilent\EEsof_License_Tools\licenses folder of each local machine.
Configure the ADS_LICENSE_FILE to point to the license file.

Typically it is best to use the port@host syntax to set the ADS_LICENSE_FILE to point to
the license server.

set ADS_LICENSE_FILE=27000@joshua

Where 27000 is the TCP port on the SERVER line in the license.lic file and joshua is the
host name of the license server.

If your license server is set up to search for an available port, use the @host syntax to set
the ADS_LICENSE_FILE to point to the license server.

set ADS_LICENSE_FILE=@joshua

You can also set the ADS_LICENSE_FILE to point to the full path and filename of the
license.lic file used by the license server.

 

 Set Environment Variables
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The Agilent License Information Tool is available to check your environment variable
settings, display your license.lic file, and shows your license and server status. If you
use the default license file location, the environment variables are set automatically. To
use the license.lic file from a different location, you have to set the ADS_LICENSE_FILE
environment variable to point to the location.

 Setting Environment Variables For Floating License

You can set the environment variables for Floating licenses as follows:
The environment variable can be entered either as a user variable or as a system variable.
The user variable affects only the currently logged-in user; the system variable affects all
users. For a node-locked license, be sure you add the ADS_LICENSE_FILE variable to the
System variables, not the User variables.

If you are running multiple versions of ADS, do not include the HPEESOF_DIR variable in
the System variables or User variables list boxes (and remove them have you have them).
You need to configure each client machine to access the license server and to check out a
license. You can do this by using one of the following methods:

Place a copy of the license.lic file in the C:\Program
Files\Agilent\EEsof_License_Tools\licenses folder of each local machine.
Configure the ADS_LICENSE_FILE to point to the license file.

It is recommended to use the port@host syntax to set the ADS_LICENSE_FILE to point to
the license server, as shown below:

set ADS_LICENSE_FILE=27000@joshua

Where 27000 is the TCP port on the SERVER line in the license.lic file and joshua is the
host name of the license server.

If your license server is set up to search an available port, use the @host syntax to set the
ADS_LICENSE_FILE to point to the license server, as shown below:

set ADS_LICENSE_FILE=@joshua

You can also set the ADS_LICENSE_FILE to point to the full path and filename of the
license.lic file used by the license server.

 Setting Environment Variables For Node Locked License

You can set the environment variables for Floating licenses as follows:
For a node-locked license, add the ADS_LICENSE_FILE variable to the System variables,
not the User variables.

 

 Launch ADS
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To run ADS from the Start menu choose Programs > Advanced Design System
2011.01 > Advanced Design System 2011.01.
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 Managing ADS Licenses
This section provides information about how to manage ADS licenses and all the tools and
utilities.

 
 

 License Information Tool
The Agilent License Information Tool is available to check your environment variable
settings, display the license.lic file, and show your license and server status. You can
access this tool in the following three ways:

From the Start menu, choose Programs > Advanced Design System 2011.01 >
ADS Tools > License Information Tool.
From the ADS Main window, choose Tools > License Information.
From C:\program Files\agilent\EEsof_License_Tools\bin, run aglmtool.exe.

For a current list of licenses available from Agilent EEsof with product descriptions and
part numbers, see License Codewords (instalpc).

  
 

 License Preference Tool
License bundles typically start with "b_" in their names. A bundle looks like any other
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INCREMENT line in the license file, but ADS recognizes the feature name as a collection, or
bundle, of individual features. When ADS checks out the license bundle, it enables all the
functionality associated with the individual features.

By default, an ADS run-session has all the bundles available for checkout. However the
License Preference Tool can be used to limit the set of license bundles to be used by your
ADS session. It records such information in the environment variable
ADS_LICPREF_<hostname>. If you need more bundle selection flexibility to control which
licenses are used on selected systems, see Manually Setting the License Bundle
Preference.

 

 Running the License Preference Tool

To start the License Preference Tool, from the Start menu, choose Programs >
Advanced Design System 2011.01 > ADS Tools > License Preference Tool. The
License Preference tool allows you to view the available license bundles and their features,
and select bundles.

To see the features available in a bundle, click the expansion icon next to the bundle
name under Available License Bundles.
To select a bundle, choose one of the bundles listed under Available License
Bundles, then click Add button. The selected bundle appears under Selected
License Bundles.
To accept your choice, click OK. This sets the environment variable
ADS_LICPREF_<hostname> in
HKEY_CURRENT_USER\Software\Agilent\EEsof_License_Configuration registry.

Note
You must have Write permissions to update the registry settings.
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 How the License Preference Tool Works

When you run the License Preference tool, it attempts to locate a license file using
the following license definitions:

Environment variable ADS_LICENSE_FILE
HKEY_CURRENT_USER\Software\Agilent\EEsof_License_Configuration in the
registry

The License Preference Tool will show all possible bundles if a license file is not
located.
You can select a bundle according to specific rules controlled by the License
Preference Tool.
If required, you can select a particular license bundle (if you have purchased more
than one license bundles) using the License Preference Tool.
If, while using ADS, the feature you attempt to use is not in the currently selected
bundle, ADS will attempt to check out a valid floating or nodelocked license for the
feature. This is known as license roll-over. If license roll-over fails to check out a
license, ADS displays a license error if another bundle with the requested feature is
available.
You can then select another bundle that contains the feature. Save your work and
exit ADS. Then, run the License Preference Tool to remove and add bundles, and
restart ADS.

 License Preference Not Set

When license preference has not been set, ADS attempts to checkout licenses in the order
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listed below. In this example, ads_schematic is the requested license.

ADS first looks for an Element license that contains ads_schematic.

If such an ELEMENT is found, ADS pulls that Element to satisfy the license request.
if no such Element is found or available, then ADS looks for a Standalone
ads_schematic license.

If such a STANDALONE is found, ADS pulls that Standalone to satisfy the license
request.

if no such Standalone is found or available, then ADS looks for a Bundle that
contains ads_schematic.

If such a BUNDLE is found, ADS pulls that Bundle to satisfy the license request.
the least expensive bundle available that contains ads_schematic is used to
satisfy the license request.
an informational dialog pops up showing the bundle that was pulled to satisfy
the license request (shown below)
if no such Bundle is found or available, then a license denial occurs.

 License Preference Set

When license preference has been set, ADS attempts to checkout licenses in the order
listed below. License preference is usually set using the License Preference Tool.

The License Preference Tool enables multiple feature bit bundles to be selected together in
order of precedence. This example uses ads_schematic as the requested license.

Setup:
The following list of bundles are selected with the License Preference Tool:

Bundle A
Bundle B
...
Bundle N

If BUNDLE A is available and it contains ads_schematic, ADS pulls Bundle A to satisfy
the license request.

if Bundle A is not available or does not contain ads_schematic, ADS looks at the
next bundle in the list to satisfy the license request.

If Bundle B is available and it contains ads_schematic, ADS pulls Bundle B to satisfy
the license request.

if Bundle B is not available or does not contain ads_schematic, ADS looks at the
next bundle in the list to satisfy the license request.
all bundles specified in your license preference are tried in order of their listing
until reaching the last bundle in the list.
...

If Bundle N is available and contains ads_schematic, ADS pulls Bundle N to satisfy
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the license request.
if Bundle N is not available or does not contain ads_schematic, ADS looks for an
Element that contains ads_schematic license.

If such an ELEMENT is found, ADS pulls that Element to satisfy the license request.
if no such Element is found or available, ADS looks for a Standalone
ads_schematic license.

If such a STANDALONE is found, then ADS pulls that Standalone license to satisfy the
license request.

if no such Standalone is found or available, a license denial occurs.

 

 Special Licensing Needs
Be sure to use the lmtools utility to install an ADS license on a server that is already
running FLEXnet. For details on using FLEXnet, refer to the Flexera website at:

http://www.flexera.com/

 

 Using FLEXnet Options

 An options file enables the license administrator to control the security parameters of
FLEXnet. Specifically the license administrator can:

Allow the use of features based on user, hostname or display name.
Deny the user of features based on user, hostname or display name.
Reserve licenses based on user, hostname or display name.
Control the amount of information logged about license usage.

 

 Creating an Options File

Use the desired options listed to create the options file using any text editor. Ideally, you
should keep the options file in the same directory as your license.lic file. Also, add the
pathname to the options file in the license.lic file as the fourth field on the VENDOR line
for agileesofd as shown in the following example. (Remember to use the backslash ('\')
character if the file contains wrapped lines.)

VENDOR agileesofd c:\\licenses\vendors\agileesofd \

c:\\licenses\agileesofd.opt

You can include comments in your options file by starting each comment with a pound
sign '#'. Everything in the options file is case-sensitive. Be sure that user names and
feature names, for example, are entered correctly. The available options are:

http://www.flexera.com/
http://www.flexera.com/
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EXCLUDE
Deny a user access to a feature.
EXCLUDEALL
Deny a user access to all feature served by this vendor daemon.
GROUP
Define a group of users for use with any options.
INCLUDE
Allow a user to use a feature.
INCLUDEALL
Allow a user to use all features served by this vendor daemon.
NOLOG
Turn off logging certain items.
REPORTLOG
Specify that a logfile be written suitable for use by the FLEXadmin End-User
Administration Tool.
RESERVE
Reserve licenses for an individual user or groups of users.
TIMEOUT
Works only for specified simulator and library licenses.
TIMEOUTALL
Works for all simulator and library licenses.

Use the following steps to create and use an options file. Details about each step located
in previous sections:

Create an options file with your required options.1.
Modify your license.lic file so that the VENDOR or DAEMON line points to this option2.
file as shown in this example:

VENDOR agileesofd c:\\licenses\vendors\agileesofd \

c:\\licenses\agileesofd.opt

Start up your license server (lmgrd) that is pointing to your license file. You must3.
stop it first if it is running. It's important that a message is displayed or recorded in
the FLEXnet log verifying the license manager is using the options file. The following
example shows that the license manager is using the agileesofd.opt file containing
the TIMEOUTALL option set to 900 seconds:

17:35:14 (agileesofd) Using options file: "c:\\licenses\agileesofd.opt"

17:35:15 (agileesofd) ALL FEATURES: INACTIVITY TIMEOUT set to 900 seconds

Set ADS_LICENSE_FILE to point to your license server.4.
Run ADS.5.

 

 Specifying the TIMEOUT Option

 You can set a custom time-out period for simulator and library licenses using the
TIMEOUT or TIMEOUTALL options. If you do not specify a time-out value in your options
file or do not have an options file, a default two-hour limit is used. These time-out options
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apply to those application features that have explicitly implemented time-out via the
heartbeat function. This includes licenses for the Analog/RF and Signal Processor
simulators and for libraries, and do not affect licenses for the design environment and
data display. The time-out option sets the amount of time a feature may remain idle
before its license is released and reclaimed by the vendor daemon. The TIMEOUT option
enables you to identify specific licenses, and the TIMEOUTALL affects all licenses
(simulators and libraries).

To use TIMEOUT, add an entry for each feature to the options file using the following
format:

TIMEOUT feature_name seconds
where:
feature_name is name of the feature.
seconds is the number of seconds before inactive license is reclaimed. The
minimum value is 900 seconds (15 minutes). If you specify a time-out value
smaller than the minimum, the minimum is used.

The option TIMEOUTALL works just like TIMEOUT, but applies to all features.

TIMEOUTALL seconds

Here are example entries you can include in your options file:

To set a time-out for the harmonic balance simulator to one hour (3600
seconds):
TIMEOUT sim_harmonic 3600

To set time-outs for multiple simulators to different periods:
TIMEOUT sim_linear 900

TIMEOUT sim_harmonic 3600

TIMEOUT sim_convolution 3600

To set a time-out for all simulators and libraries to one hour (3600 seconds):
TIMEOUTALL 3600

 

 Updating the License File

 If you have been running FLEXnet and receive updated licenses from Agilent EEsof, you
can add the new licenses to the FLEXnet environment as follows:

Replace the existing license.lic files on the license servers and clients with the new1.
license.lic file.
On the primary server, run lmutil lmreread. This causes the lmgrd on the primary2.
server to re-read the license.lic file and update all of the other lmgrd processes on
the network.
After you have done this, you can run lmutil lmstat -a to verify that the license3.
servers have received the new license information.
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If this does not work, you may need to stop all of the lmgrd processes and then re-restart
lmgrd again.

 

 Merging Multiple Vendor Licenses

 When you are running FLEXnet-licensed products from multiple vendors, you have three
ways to prevent licensing conflicts during installation:

Multiple license server nodes; each running one lmgrd and one license file
One license server node running one lmgrd and one license file
One license server node running multiple lmgrds and multiple license files

Each lmgrd can only read a single license file. With the first option you will have more
license servers to monitor. With the third option you have only one server but multiple
lmgrds to administer.

Your product's license file(s) define the license server(s) by hostname and hostid in the
SERVER line(s) in the license file.

If the license files for two or more products contain identical hostids on the SERVER
line(s), then these files can be combined.
If the license files for two products contain different hostids on a SERVER line, then
the license servers for those products will be running on different nodes and the
license files cannot be combined.

If you have two or more products whose license servers run on the same node (as
specified by the SERVER lines in the license files), you may be able to combine the license
files into a single license file.

If the SERVER lines in those files have identical hostids, then you can combine the
files into a single file.
If the SERVER lines have different hostids, then you must keep the license files
separate.

Essentially, you can combine two license files under the following conditions:

The number of SERVER lines in each file is the same.1.
The hostid field of each SERVER line in one file exactly matches the hostid field of2.
each SERVER line in the other file.

Some possible reasons license files may not be compatible are:

License files are set up to run on different server nodes, so hostids are different.
One file is set up for single server (has only one SERVER line), the other is set up for
redundant servers (has multiple SERVER lines).
One vendor uses a custom hostid algorithm, so the hostids on the SERVER lines are
different even though the files are for the same machine.
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If your license files are compatible as described above, then you can combine license files
and run a single lmgrd, as described in Combining License Files from Multiple Vendors If
the license files are not compatible, then you must keep the license files separate and run
separate copies of lmgrd for each license file, as described in the section, Using Separate
License Files on the Same Server Node. For specific information about combining licenses
for multiple versions of ADS, see Managing Multiple ADS Versions.

Important
There is virtually no performance or system-load penalty for running separate lmgrd processes.

 

 Combining License Files from Multiple Vendors

If your license files are compatible, you can combine them using any text editor. To
combine license files, read all of the compatible license files into one file, then edit out the
extra SERVER lines so that only one set of SERVER lines remains. Write out this data, and
you have your combined license file.

If you combine license files from multiple vendors, it is a good idea to keep a copy of the
combined license file in each vendor's default license file location. This way, your users
can avoid having to set ADS_LICENSE_FILE, because each package finds its license
information in the default place. On UNIX or Linux, you can do this with a symbolic link
from each default location to the location of the combined license file.

 

 FLEXnet Version Component Compatibility

When you combine license files for two different FLEXnet-licensed products, the products
may not use the same version of FLEXnet. FLEXnet is designed to handle this situation.
There are two basic compatibility rules for FLEXnet:

A newer lmgrd can be used with an older vendor daemon, but a newer vendor1.
daemon might not work properly with an older lmgrd.
A newer vendor daemon (or lmgrd) can be used with an older client program, but a2.
newer client program might not work properly with an older vendor daemon.

From these two compatibility rules come the simple rules for selecting which version of
administration tools to use:

Always use the newest version of lmgrd and the newest version of each vendor1.
daemon.
Use the newest FLEXnet utilities.2.

For specific application programs, you can use either the new or the old version (with the
assumption that the vendor daemon for that application is at least as new as the
application).
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 Using Separate License Files on the Same Server Node

You must run a separate copy of lmgrd for each license file. When you run multiple copies
of lmgrd, there are two details to remember:

The port number on the SERVER line of each license file must be unique. You can use1.
a standard text editor to change the port number in each license file so that they are
all different.
You must make sure that you are using a compatible version of lmgrd when you start2.
it up for a particular license file. This can be done by using an explicit path to lmgrd.

When running client programs (such as a licensed application), you can set the
ADS_LICENSE_FILE environment variable to point to multiple license files. For example,
you may have a license file from vendor ABC and a license file from vendor XYZ with
incompatible servers. You can place the license file from vendor ABC into:

c:\user\default\abc.lic

and the license file from vendor XYZ into:

c:\user\default\xyz.lic

then set the ADS_LICENSE_FILE environment variable to point to both of them. The
syntax is as follows:

ADS_LICENSE_FILE=27000@server1;27000@server2;27000@server3

Note that each path is separated with a semi-colon.

ADS_LICENSE_FILE can point to only one license file for FLEXlm v1.x applications.

 

 Redundant License Servers

 FLEXnet enables you to set up a redundant license server configuration. This involves
configuring three license servers with one of the three servers functioning as the master
server. If the master server goes down, one of the other two servers becomes the new
master server, and the licenses remain available on the network.

Setting up redundant servers requires extra system administration and is not
recommended unless you absolutely need it.

To set up redundant license servers, use the same FLEXnet procedures on all three
servers. All three servers need to be up and running before your licenses will be made
available.
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Note
You must explicitly set the port number, for example 27005, and complete the license setup again.

  

 Manually Setting the License Bundle Preference

If you are using license bundles, you are aware that you must select a bundle prior to
running ADS. Typically, bundles are selected by using the Agilent License Preference Tool.
This tool is discussed in Using the Agilent License Preference Tool. However, system
administrators and advanced users can manually configure environment variables when
they need more bundle selection flexibility. Proper configuration using these environment
variables control which licenses are used, and the systems using them.

The two environment variables that control bundle selection are:

 AGILEESOFD_LICPREF<hostname>_ controls bundle selection specifically for the
system identified by <hostname>.
 AGILEESOFD_LICPREF controls bundle selection for all systems on a network with
access to the license server.

ADS looks for these variables in the following locations in the order given here:

Shell environment
HKEY_CURRENT_USER\Software\Agilent\EEsof_License_Configuration

ADS first looks for AGILEESOFD_LICPREF<hostname>_ in each of these locations. If ADS
cannot find a value for AGILEESOFD_LICPREF<hostname>, then ADS looks for
_AGILEESOFD_LICPREF. If AGILEESOFD_LICPREF is not found, no bundle is selected.

 

 Examples

Joe Smith wants to use the _b_core_ bundle when he runs ADS on the system with
the hostname alpha. To set this up, Joe should add
the environment variable{{ADS_LICPREF_ALPHA=b_core}}
A system administrator wants to configure a system to use the _b_core_ bundle
when anyone runs ADS on the system named beta, and to use the _b_hb_layout_
bundle when ADS is run on other systems. To set this up, the administrator should
add the environment variables
ADS_LICPREF_BETA=b_core and
ADS_LICPREF=b_hb_layout

  

 Accessing Licenses through a Firewall

There may be situations where it is necessary to check out FLEXnet licenses through a
firewall (or router). This may occur when a license server is behind a company firewall and
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other sites or companies need to check out licenses.

Assuming your license agreement allows you to serve licenses in this manner, you can
enable license checkout through a firewall by configuring your firewall to allow TCP
communication through the TCP ports used by the license manager daemon (lmgrd) and
any vendor daemons you will run.

For example, assume you have a license server serving EEsof EDA licenses and your
license.lic file contains the following lines:

SERVER myserver 00809AC7123F8

VENDOR agileesofd c:\apps\flexnet\vendors\agileesofd

VENDOR agileesof c:\apps\flexnet\vendors\agileesof

DAEMON hpeesofd c:\apps\flexnet\vendors\hpeesofd

To set up your firewall to allow TCP access to the license server, you must specify a TCP
port number for lmgrd on the SERVER line and for each vendor daemon on the VENDOR or
DAEMON lines. For example:

SERVER myserver 00809AC7123F8 27000

VENDOR agileesofd c:\apps\flexnet\vendors\agileesofd port=1705

VENDOR agileesof c:\apps\flexnet\vendors\agileesof port=1706

DAEMON hpeesofd c:\apps\flexnet\vendors\hpeesofd port=1707

Note
After specifying TCP ports in your license.lic file, you must stop and restart your license server.

Next, configure your firewall or router to allow TCP communication through the TCP ports
you specified in your license.lic file. In the example above this would be ports 27005,
1705, 1706, and 1707.

Finally, clients must set the ADS_LICENSE_FILE environment variable to the port number
assigned to the license server. Using the example above, the setting would be:

ADS_LICENSE_FILE=27005@myserver

Once this has been done, clients outside of the firewall will be able to access licenses from
your server.

Note
  Some clients may timeout before they can connect to a license server through a firewall set up on a
Windows PC. The default timeout period is 0.1 second. If you need a longer timeout period, you can set
the environment variable FLEXLM_TIMEOUT to a new value. Enter the value using microseconds. Agilent
EEsof recommends trying one second. For example:

FLEXLM_TIMEOUT=1000000

Depending on your network, you may need to adjust the period so it is long enough to allow connections
without slowing down simulations excessively.
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 Managing Multiple ADS Versions
This section provides information about how to manage the licenses for multiple versions
of ADS.

 

 Backward Compatibility of Licenses

 The following table lists ADS versions with details of their license management:

Release
Name

License
File
Version

Daemon
Name

FLEX
Version

License Environment
Variable

Default License File Location

ADS 1.5 1.5 hpeesofd FLEXlm
7.0g

LM_LICENSE_FILE $HPEESOF_DIR/licenses/license.dat

ADS
2001

1.7 hpeesofd FLEXlm
7.0g

HPEESOFD_LICENSE_FILE $HPEESOF_DIR/licenses/license.dat

ADS
2002

1.9 agileesof FLEXlm
7.2h
CRO

AGILEESOF_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2002C

2.1 agileesof FLEXlm
7.2h
CRO

AGILEESOF_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2003

2.3 agileesofd FLEXlm
8.2a
CRO

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2004

2.34 agileesofd FLEXlm
9.2a
CRO

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2005

2.35 agileesofd FLEXnet
10.1.3
CRO

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2006

2.6 agileesofd FLEXnet
10.8
CRO

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2008

2.7 agileesofd FLEXnet
11.4.1

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2009

2.8 agileesofd FLEXnet
11.6

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2009U1

2.8 agileesofd FLEXnet
11.6

ADS_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

ADS
2011.01

2.9 agileesofd FLEXnet
11.9

ADS_LICENSE_FILE C:\program
Files\agilent\EEsof_License_Tools\license.lic

The following table lists the license compatibility between various ADS releases. Note that
license compatibility also depends on the whether the license was available in that
release.
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Licenses From
This Release

ADS
2011

ADS
2009

ADS
2008

ADS
2006

ADS
2005A

ADS
2004A

ADS
2003C

ADS
2003A

ADS
2002C

ADS
2002

Will Work With
This Release

         

ADS 20011 X X X       

ADS 2009U1 X X X       

ADS 2009 X X X       

ADS 2008  X X X      

ADS 2006   X X X     

ADS 2005A    X X X X   

ADS 2004A     X X X   

ADS 2003C      X X   

ADS 2003A      X X   

ADS 2002C        X X

ADS 2002        X X

 Combining ADS Licenses with Other Agilent EEsof EDA Licenses

 For ADS 2011, the vendor daemon agileesofd is used. This is the same vendor daemon
that was used for ADS earlier versions of ADS. If you want to serve ADS 2011 licenses
and earlier from the same server, you need to have the latest version of lmgrd, v9.2a,
and two or three DAEMON lines in your license file, depending on how many versions you
want to support. The ADS daemon names available are:

agileesofd - for ADS 2003A, 2003C, 2004A, 2005A, 2006A, and 2006 Update
agileesof - for ADS 2002 and 2002C
hpeesofd - up to and including ADS 2001

For example, the license file would include:

SERVER xyzmems 77a588a7 1700

VENDOR agileesofd c:\ADS2009U1\licenses\vendors\agileesofd

VENDOR agileesof c:\ads2002C\licenses\vendors\agileesof

DAEMON hpeesofd c:\ads2001\licenses\vendors\hpeesofd

You would then add the INCREMENT lines for the different products to the file.

The name and extension of the license file are arbitrary (i.e., license.dat, license.lic or
adslicenses.txt). By default, all ADS versions up to and including ADS 2001 look for a file
named license.dat and all ADS versions from ADS 2002 to ADS 2009 Update 1 look for a
file named license.lic. You can use one of these names, or some other name you prefer.
Whatever name you choose to use, make sure you set the environment variables to point
to your license file.

The supported environment variables are:

ADS_LICENSE_FILE for ADS 2003A through 2009
AGILEESOF_LICENSE_FILE for ADS 2002 and 2002C
HPEESOFD_LICENSE_FILE for ADS 2001
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LM_LICENSE_FILE for ADS 1.5 and earlier

For example, if the combined license file is named adslicenses.txt and you want to build a
license file that contains ADS 2009 Update 1, ADS 2003C, ADS 2002C, ADS 2001, and IC-
CAP 2001 licenses, then:

ADS 2003C and 2009 will use:
ADS_LICENSE_FILE=c:\licenses\adslicenses.txt
ADS 2002C will use:
AGILEESOF_LICENSE_FILE=c:\licenses\adslicenses.txt
ADS 2001 will use:
HPEESOFD_LICENSE_FILE=c:\licenses\adslicenses.txt
IC-CAP 2001 will use:
LM_LICENSE_FILE=c:\licenses\adslicenses.txt

Each version of ADS uses a certain search order to look for the environment variable:

ADS 2003C through 2009 Update 1 will first look for the environment variable named
ADS_LICENSE_FILE. If ADS_LICENSE_FILE and LM_LICENSE_FILE are both defined,
ADS 2003C through 2009 Update 1 will use ADS_LICENSE_FILE and ignore
LM_LICENSE_FILE. If ADS_LICENSE_FILE is not defined, then ADS 2003C through
2009 Update 1 will default to LM_LICENSE_FILE.
ADS 2002 and 2002C will first look for the environment variable named
AGILEESOF_LICENSE_FILE. If AGILEESOF_LICENSE_FILE and LM_LICENSE_FILE are
both defined, ADS 2002 and 2002C will use AGILEESOF_LICENSE_FILE and ignore
LM_LICENSE_FILE. If AGILEESOF_LICENSE_FILE is not defined, then ADS 2002 and
2002C will default to LM_LICENSE_FILE.
ADS 2001 will first look for the environment variable named
HPEESOFD_LICENSE_FILE. If HPEESOFD_LICENSE_FILE and LM_LICENSE_FILE are
both defined, ADS 2001 will use HPEESOFD_LICENSE_FILE and ignore
LM_LICENSE_FILE. If HPEESOFD_LICENSE_FILE is not defined, then ADS 2001 will
default to LM_LICENSE_FILE.
All previous ADS versions, up to and including ADS 1.5 will use LM_LICENSE_FILE.

Even though all versions of ADS will default to LM_LICENSE_FILE if that is the only
environment variable that exists, it is recommended that you use the supported
environment variables listed above.

 

 Example of a Merged License File

SERVER solarone 80FB214D 1700

DAEMON hpeesofd c:\hfs\d1\local\licenses\hpeesofd

VENDOR agileesof c:\hfs\d1\local\licenses\agileesof

VENDOR agileesofd c:\hfs\d1\local\licenses\agileesofd

#

# ADS 2001 licenses

#

INCREMENT Adapt_comp hpeesofd 1.5 03-nov-2002 5 EC7A98E3FB4AC8771142 \

       VENDOR_STRING=s=80FB214D
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INCREMENT Ad_da_appkit hpeesofd 1.5 03-nov-2002 5 \

       1CCA189368AF358196C4 VENDOR_STRING=s=80FB214D

INCREMENT Ampsa_appkit hpeesofd 1.5 03-nov-2002 5 \

       0CBAB813D8101E34EB55 VENDOR_STRING=s=80FB214D

INCREMENT Analog_lib hpeesofd 1.5 03-nov-2002 5 9CEA88930822C5CF81AC \

       VENDOR_STRING=s=80FB214D

INCREMENT Tx_appkit hpeesofd 1.5 03-nov-2002 5 6C0A5873869F9624DFF5 \

       VENDOR_STRING=s=80FB214D

INCREMENT User_defined_model hpeesofd 1.5 03-nov-2002 5 \

       2CAAE8E326E3D9DD888B VENDOR_STRING=s=80FB214D

INCREMENT Verilog_code_gen hpeesofd 1.5 03-nov-2002 5 \

       FCAA489350CD03768D44 VENDOR_STRING=s=80FB214D

INCREMENT Vhdl_code_gen hpeesofd 1.5 03-nov-2002 5 \

       FC4A58B306109B640C5C VENDOR_STRING=s=80FB214D

INCREMENT Wcdma3g_des_lib hpeesofd 1.5 03-nov-2002 5 \

       DC7AA89389009E4B61BF VENDOR_STRING=s=80FB214D

INCREMENT Wcdma_des_lib hpeesofd 1.5 03-nov-2002 5 \

       7C0A38F308FA2C30CE3D VENDOR_STRING=s=80FB214D

INCREMENT Wlan_des_lib hpeesofd 1.5 03-nov-2002 5 \

       4C8A6893E259E6C86399 VENDOR_STRING=s=80FB214D

#

# IC-CAP 2001 licenses

#

INCREMENT a_si_tft agileesof 6.0 29-oct-2001 1 D0A4535DE290 \

       VENDOR_STRING=s=80FB214D

INCREMENT ac_driver agileesof 6.0 29-oct-2001 1 1A9EE36873A0 \

       VENDOR_STRING=s=80FB214D

INCREMENT analysis agileesof 6.0 29-oct-2001 1 025C2B939BD5 \

       VENDOR_STRING=s=80FB214D

INCREMENT curtice_statz_fet agileesof 6.0 29-oct-2001 1 7D88F11FEE4B \

       VENDOR_STRING=s=80FB214D

INCREMENT dc_driver agileesof 6.0 29-oct-2001 1 65C14D4C7948 \

       VENDOR_STRING=s=80FB214D

INCREMENT gummel_poon_bjt agileesof 6.0 29-oct-2001 1 8FB9632C0555 \

       VENDOR_STRING=s=80FB214D

INCREMENT ucb_bsim3 agileesof 6.0 29-oct-2001 1 BEDFA8C2810F \

       VENDOR_STRING=s=80FB214D

INCREMENT ucb_bsim4 agileesof 6.0 29-oct-2001 1 D454A8AB830D \

       VENDOR_STRING=s=80FB214D

INCREMENT ucb_mos2_mos3 agileesof 6.0 29-oct-2001 1 D9768F388827 \

       VENDOR_STRING=s=80FB214D

INCREMENT vbic_bjt agileesof 6.0 29-oct-2001 1 3DE6FB45CD8C \

       VENDOR_STRING=s=80FB214D

#

# ADS 2002C licenses

#

INCREMENT ads_datadisplay agileesof 2.0 30-jun-2002 1 \

       VENDOR_STRING=80FB214D HOSTID=80fb214d SIGN="008E 5A70 FECF \

       8BEF 9B3A 8A67 7375 0A51 0940 A264 6B00 C335 666B 03E2 D8E7 \

       99A8 A0F9 9007 2AC4 EF7D E101"

INCREMENT ads_datadisplay agileesof 2.0 30-jun-2002 1 \

       VENDOR_STRING=80FB214D SIGN="01CB 4272 B241 5A67 A4C8 CADB \

       A080 FFB2 7796 6C29 EC02 C3A9 FD8A BE47 C0C0 F027 5552 947F \

       64CC 06BA 2201"

INCREMENT ads_drc agileesof 2.0 30-jun-2002 1 VENDOR_STRING=80FB214D \

       HOSTID=80fb214d SIGN="0138 3E48 7191 3703 8FFB 2614 067B 2A7E \

       203F 4F0C C900 79FE F186 9B1E 2B10 3B3D D650 2204 18CF 00C9 \

       3E3A"

INCREMENT trans_veriloggen agileesof 2.0 30-jun-2002 1 \

       VENDOR_STRING=80FB214D HOSTID=80fb214d SIGN="014D A119 4C16 \
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       9831 16B3 B5C6 EFE7 ED11 D0AE F389 EA00 590B 0E0A E0CD 5E4D \

       9CE6 E6AD B27E 2CC4 8C1A 1D9D"

INCREMENT trans_veriloggen agileesof 2.0 30-jun-2002 1 \

       VENDOR_STRING=80FB214D SIGN="0332 DEBA 8398 B80F D2A0 0237 \

       BF97 0C7E 1CF3 CB15 2902 A5CB 47FA ECCB 9C6B BED2 E3D9 FBEB \

       EF84 FAFE 7AC8"

INCREMENT trans_vhdlgen agileesof 2.0 30-jun-2002 1 \

       VENDOR_STRING=80FB214D HOSTID=80fb214d SIGN="03D0 0C40 7E3C \

       E656 F8A8 ADF2 B161 97C1 CE6C DC0C DA00 A704 91C9 F5A0 30C6 \

       DA2A 60C0 A435 E003 02A0 C7A4"

INCREMENT trans_vhdlgen agileesof 2.0 30-jun-2002 1 \

       VENDOR_STRING=80FB214D SIGN="028D FD25 D0E4 AD1A A0B7 5D61 \

       E2A8 7CC2 8135 D605 8200 F200 39D8 E5AF 4B9E D240 3682 4BAA \

       D9BD 6FB3 E580"

#

#ADS2003C licenses

#

INCREMENT ads_datadisplay agileesofd 2.3 07-jul-2003 1 \

       VENDOR_STRING="00047518D858 : O2GAZUD WSGSONJ 2HNECZL 12WKCKE \

       LRXYGSO MWYFKGP AKBPONX LOYSO" HOSTID=00047518d858 SIGN="0246 \

       771A BBA2 A0D4 B29E 7371 6FF7 F3D9 161A 1204 EE00 2E92 8AC0 \

       1AF7 FAF9 5B2C B017 23F7 91E8 BF97 B9AD"

INCREMENT ads_drc agileesofd 2.3 07-jul-2003 1 \

       VENDOR_STRING="00047518D858 : QEGHABO KEYWTHV 1HEIWND JFAVQ2A \

       UJXJ2EW KYARWEQ GY" HOSTID=00047518d858 SIGN="02EC 9EA3 EE62 \

       BDBC 9793 019D 0551 FD3E 20DD D0C1 D301 DA95 9F79 16A8 5E11 \

       1B81 E7CC 90F8 68A0 E116 8F0B"

INCREMENT ads_encoder agileesofd 2.3 07-jul-2003 1 \

       VENDOR_STRING="00047518D858 : GONJAZX FHGGNAP BWOGIAH PBKWEYK \

       UCKGULO YSO2GAZ UDWSGS" HOSTID=00047518d858 SIGN="027B 178E \

       2893 8446 A5C4 0990 830E CC2C F215 528B 6401 9B93 9540 A54C \

       B85A A68E 0049 200F 1685 96D1 FD7F"

INCREMENT ads_layout agileesofd 2.3 07-jul-2003 1 \

       VENDOR_STRING="00047518D858 : BUYPSCY ESZGY2G PVZBPON XODFINY \

       IUIUACJ EFQGAUY XLYSX" HOSTID=00047518d858 SIGN="032E E2FE \

       1D41 5386 F290 C7AA 207B 20C6 9187 D2D5 0D00 7DB9 8FF8 531A \

       9947 9A9D 5D72 A8E6 9807 3037 F7EA"

#

# ADS2009 licenses

#

INCREMENT ads_datadisplay agileesofd 2.7 08-nov-2007 1 \

               VENDOR_STRING="8-5E7012345678 : DXNLFPQ WZBCLQ2 AUJXJ2E \

               IEKCKLI WFYQNVM DNJU1YM LHYKAQC OM" START=11-nov-2007 \

               SIGN="028C 541A A8DE F4CD 9796 2D38 BC5A 7588 F431 7E62 0601 \

               95CE F386 0A87 0B26 7EE7 7FEB 9DE4 60E9 6DDE 0340"

INCREMENT ads_schematic agileesofd 2.7 08-nov-2007 1 \

               VENDOR_STRING="8-5E7012345678 : KSGSOTJ D1JYAKF UZJFEJI \

               U2CRZDW FYANHIW HKMNMAU FQ1AQPJ UGW" START=11-nov-2007 \

               SIGN="02B0 5CFB 3F35 006F CDC5 1BBE DE50 831E 54DC A024 A301 \

               A491 42EA A1AA 3E41 C43D 5B63 E82D 3B51 8961 005D"

INCREMENT mdl_systemlib agileesofd 2.7 08-nov-2007 1 \

               VENDOR_STRING="8-5E7012345678 : PGNPGMU IWQUFPY PNDJKYU \

               GNHSULC KL2RXY2 NXAHEGC TLRDCYB RW1Q" START=11-nov-2007 \

               SIGN="02E9 3C03 1616 0BC9 5E70 C088 5D86 770F E8D4 862C D803 \

               E25B CDD5 EB9D AA31 FD4B 2C30 ED41 4635 3420 A4FD"

INCREMENT sim_convolution agileesofd 2.7 08-nov-2007 1 \

               VENDOR_STRING="8-5E7012345678 : DSXUYDA CHECD1Y 2NMAJPB \

               CESQD2M JX2LGBG QWPS1OK RTEIQGA UYDLY" START=11-nov-2007 \

               SIGN="0153 1869 9B6E C851 5225 A333 0727 E795 BE74 8C5D 0302 \

               E9BC E165 4F3D E4D4 D7BF E530 3CC5 B760 830E 9C95"
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Note
In the license file, # can be used to comment out the incremental codewords.
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 Using Advanced Design System after
Windows Installation
This section provides information about different ways to launch ADS.

  

 Running Advanced Design System
Your ADS licenses must be properly configured and installed before you can run ADS. To
set up your license file, follow the instructions in Setting Up Licenses (instalpc).

Note
ADS License Setup Wizard starts automatically if there are any issues in ADS License setup.

 
To run ADS from the Start menu, select Programs > Advanced Design System
2011.01. The following options are available in the Start menu:

 ADS Tools: Displays a list of ADS tools, such as Digital Filter Designer, or LineCalc if
they have been installed. Choose the tool you want to launch (provided you have
licensed these features). Other tools include the License Information Tool, License
Preference Tool, and the Ptolemy Modelbuilder Shell.
 ADS Resources: You can access the ADS online help from here. The documentation
files are accessed from the location in which they are installed (if you chose to install
documentation).
 Advanced Design System 2011.01: Launches the ADS Main window and the use
of the various ADS Suites, features and modules you have licensed. If you are not
familiar with ADS, choose Help > Topics and Index > Quick Start for help on
getting started with ADS.
 Uninstall Advanced Design System 2011.01: Launches the Uninstall Program.
For more information about this utility, refer to the section, Using the Uninstaller.

  

 Running ADS in Verbose Mode

You can start ADS in the verbose (debug) mode to store and display the information about
what is happening as ADS runs. This additional information is displayed in an error log
window. It can be very useful to debug a problem with ADS both at startup and in general
operation. In the verbose mode, ADS creates a log file, ads_daemon.log, in the root folder
of your system disk. This file can be used to track the issue that you may face while
working with ADS. 

To start ADS in the verbose mode:

Open your Windows Explorer and navigate to the bin folder in the ADS installation1.
folder. For example,



Advanced Design System 2011.01 - Windows Installation

53

C:\Agilent\ADS201101\bin

Double-click the ads_verbose.bat file to start the ADS in the verbose mode.2.
You will notice some extra message windows as ADS starts. Click OK in each of the3.
windows to start the ADS.

To trace any error or issues you can refer to the ads_daemon.log file. For any further
assistance, you can access Agilent EEsof EDA Technical Support or e-mail your
ads_daemon.log file to the Agilent support engineer.

 Running ADS from a Network-based Installation

To install ADS on your network and run it from any PC connected to your network:

Install ADS by selecting the Complete installation option on at least one PC (the file1.
server). If you are a new user of ADS 2011, you will be asked to set your EEsof
license tools directory. Select a directory residing on the file server or copy the
contents of this directory to the file server after installing ADS.
Share the Advanced Design System installation directory and the EEsof License Tools2.
directory with the users on your network. If you are a new user of ADS 2011, you
need to share a EEsof License Tools directory to all your users. Also, if you support
the use of a batch file, set an environment variable HPEEOSF_LIC_DIR to this path
under the batch file.

Note
If you are supporting users on 32-bit versions of Windows and your original ADS installation is performed
on a 64-bit Window system, under the EEsof License Tools, you need to copy the utilities form the
bin/win32 directory to the bin directory to allow 32-bit system users to use these set of the EEsof License
Tools.

After installing ADS and EEsof License Tools on a file server, you can support your users in
the following ways:

Create a batch file to set the environment variables and to start ADS (see Creating a
Batch File to Set the Environment and Start ADS).

Use the LAN Client Installation Process .

 

 Running the Configuration Script

On each PC client, you need to run a small setup.exe configuration program. The ADS file
server contains 32-bit and 64-bit versions of the configuration program.

For 32-bit systems, run the setup.exe configuration program located here:

C:\Agilent\ADS2011_01\install\32bit\setup.exe

For 64-bit systems, run the setup.exe configuration program located here:

C:\Agilent\ADS2011_01\install\64bit\setup.exe

http://edocs.soco.agilent.com/display/ads201101/Installing+Advanced+Design+System+on+Windows#InstallingAdvancedDesignSystemonWindows-UsingtheLANClientInstallationProcess
http://edocs.soco.agilent.com/display/ads201101/Installing+Advanced+Design+System+on+Windows#InstallingAdvancedDesignSystemonWindows-UsingtheLANClientInstallationProcess
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If required, the configuration program can also be run in silent mode on the PC client. Use
the path shown above (depending on 32-bit or 64-bit) and replace setup.exe with the
following:

msiexec /q /i "%HPEESOF_DIR\install\32bit\ADS_MM_Setup.msi"

Note
Running the configuration program in silent mode successfully, depends on careful placement of the
double-quotes (").

 

 Creating a Batch File to Set the Environment and Start ADS

Create a batch file *.bat on the each PC client. The file can be located anywhere on the
PC client.

The following is an example of a Windows .bat file that sets the environment variables
and starts ADS 2011.01. The exact path name and location for the HPEESOF_DIR,
HOME,HPEESOF_LIC_DIR and ADS_LICENSE_FILE environment variables will vary
depending on your version of ADS, your home directory location, and your particular
license configuration. Check with your system administrator for details.

set HPEESOF_DIR=c:\file_server\ADS2011.01

set ADS_LICENSE_FILE=27001@ [your server name]

REM NEW for ADS 2011, you must set a HPEESOF_LIC_DIR variable

set HPEESOF_LIC_DIR=c:\file_server\EEsof_License_Tools

set PATH = %HPEESOF_DIR%\bin;%PATH%

set DOCS_DIR=%HPEESOF_DIR%\doc

set HOME=C:\users\default

cd %HOME%

%HPEESOF_DIR%\bin\ads.exe

Note
If you try to run this batch file to launch a network copy of ADS 2008 or later versions before executing
the required setup.exe (as per 32-bit or 64-bit version) configuration program, you will get an error
message similar to the following:

.\ads.exe  The application has failed to start because its side-by-side configuration is incorrect. Please see

the application event log for more detail.

 

 

 Using the ADS RF Designer Suite

You need to purchase a specific product license to access ADS RF Designer product. If
have not installed the RF Designer license, an error message is displayed when you try to
open RF Designer. To purchase this product suite, contact your Agilent EEsof sales
representative. If you have purchased this suite and are encountering the same problem,
check your license.lic file. Follow instructions in Setting Up Licenses (instalpc), for details
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on licensing procedures.
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 Troubleshooting and FAQs
 
 
This section describes some of the common problems (along with possible solutions) you
may encounter while running ADS or during ADS license setup.

 

 ADS Does Not Start

 It is possible to install ADS features for which you have not purchased licenses but you
cannot access the applications without a valid license.

If ADS applications does not start, check the following:

Ensure your ADS license setup is correct, as explained in Windows License Setup
(instalpc).
Open and review the install.log file (available in ADS installation folder) to see if
there are any apparent problems with the installation structure. (You may have to re-
install ADS.)
Check the environment variable settings using Agilent License Information Tool
(instalpc).

If you cannot find the problem, run ADS in verbose (debug) mode and contact Technical
Support to help pinpoint the problem.

 

 ADS Does Not Run After Starting the License Server

 If the following error message appears when you run ADS, license bundle selection may
be required:

No such feature exists

Feature: b_core

License path:

$HPEESOF_DIR/EEsof_License_Tools/licenses/license.lic

FLEXlm error: -5,357

This error can appear if license file (license.lic) file contains license bundles and you
have not run the Agilent License Preference Tool to select a license bundle. You must
select a license bundle using the License Preference Tool, so ADS will know to use it. See
Using the Agilent License Preference Tool .

 

 Licenses Stop Working

file:/pages/createpage.action?spaceKey=ads201101&amp;title=Setting+Up+Licenses+for+Windows+Installation&amp;linkCreation=true&amp;fromPageId=122492806
file:/pages/createpage.action?spaceKey=ads201101&amp;title=Setting+Up+Licenses+for+Windows+Installation&amp;linkCreation=true&amp;fromPageId=122492806
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 The FLEXnet software must be able to read the ethernet address of your LAN card for
your licenses to work properly. If you only have the TCP/IP protocol loaded on your PC,
then FLEXnet will be unable to read the ethernet address and ADS will not work.

You must have the NWLink IPX/SPX protocol loaded in addition to the TCP/IP protocol.

To load the NWLink IPX/SPX protocol in Windows, do the following:

Choose Start > Settings > Control Panel.1.
In the Control Panel, double-click Network.2.
In the Network dialog box, select the Protocols tab.3.
Click the Add button.4.
Select NWLink IPX/SPX Compatible Transport from the list that appears and click OK.5.
The protocol will be loaded. Once it is complete, select OK until out of the Network6.
dialog box.
To complete this procedure, reboot your PC.7.

 

 Losing Licenses When Opening Help

On network configurations, such as a VPN (virtual private network), where ADS and its
licenses are accessed through a web browser, opening an ADS help topic may break the
connection to the network. To avoid this situation, set the following Internet Explorer
option so ADS help opens in a new browser window:

In Internet Explorer, choose Tools > Internet Options.1.
Select Advanced tab in the Browsing section, disable (uncheck) Reuse windows for2.
launching shortcuts.

  

 ADS Workspace Cannot be Opened After System Restore

System Restore returns your Windows system to a previous point in time. The problem is
that System Restore targets and deletes any design .CFG files that were created after the
desired system restore point. Any ADS workspace and design files created after the
restore point are stripped of their configuration files, design files, and empty directories.
Therefore, ADS cannot open these workspaces.

If System Restore was recently used, you can recover the lost design files and repair the
corrupted ADS workspace directories by selecting Undo my last restoration from System
Restore.

After System Restore is reversed and your PC is rebooted, your ADS workspaces are
restored to working order and all design files are recovered.

If System Restore must be done for whatever reason, you should first protect any ADS
workspaces that contain recent work.
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Check with your system administrator to find out if your ADS workspaces are being
backed up regularly and if the most recent backup contains your most recent work.
If your ADS workspaces are not backed up, temporarily move your recent ADS
workspaces to a protected location for the duration of the System Restore. According
to Microsoft, the C:\Program Files directory is safe from modification by System
Restore. Remember to move your workspace back to their original location after
System Restore completes. This is important, as the ADS simulator will fail to run if
spaces exist in the path to the ADS workspace directory.

 FAQs
Following are some frequently asked questions about installation of ADS programs on the
PC.

 

 Install Over Multiple Hard Disks

 To install ADS applications over multiple hard disks, you need to re-run the Setup
program as many times as necessary, installing selected installation items to a different
destination each time.

 

 Find Flex ID of Hardware Key

 You need the nodelock ID of your hardware security key to get licenses from Agilent
EEsof. It might also be useful to access this information when you place a call to Technical
Support. There are two ways to check this:

Before you install the hardware key on your PC, you can read the ID directly from the
key.
If you have installed the hardware key on your PC, and have also already installed
your licenses and the FLEXnet software, enter the following command to check the
nodelock ID:
lmutil lmhostid -flexid

 
 

 Add ADS Files

The InstallAnywhere program can be used to install ADS features that were not installed
during the Custom installation.
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Notes

To repair your ADS installation, uninstall ADS (see Uninstalling Advanced Design System) and then1.
re-install ADS (see Installing Advanced Design System on Windows (instalpc).
Agilent EEsof does not recommend using the Add/Remove Programs feature (to un-install ADS)2.
available on the Control Panel.

 To add ADS items to an existing ADS installation (requires downloading ADS image):

Close all ADS applications, and all Windows programs. Download the ADS installation1.
file ads2011_01_rXXX_windows.exe from the Agilent EEsof EDA Web  to any folder,
say C:\Temp,
Run the self extracting installation file ads2011_01_rXXX_windows.exe from the2.
location where you saved it.
Follow the online instructions until you reach Install Set screen, then choose Custom3.
at the Choose Install Set screen, then choose Next.
At the next screen, choose the items you want to install, then choose Next to begin4.
installing the items. The Setup Status screen appears showing the installation
progress.
Click Done when the installation is complete.5.

  

http://www.agilent.com/find/eesof-ads-latest-downloads
http://www.agilent.com/find/eesof-ads-latest-downloads
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 Installing Connection Manager Server
on Windows
 
The Connection Manager server can be easily installed and used with Advanced Design
System (ADS). Follow these instructions to install the Connection Manager server and
configure the server IO.

 

 Obtaining the Software
ADS 2011 release includes Connection Manager Client by default, but it does not include
installation for Connection Manger Server (needs to reside on same/local or remote 32B
Windows XP/2K PC with latest Agilent IO Libraries software that will be connected to your
target instruments) . To use Connection Manager Server with ADS 2011, it must be
installed separately. Click here  to download the latest available version of ADS
Connection Manager Server.

For more details about ADS Connection Manager Client/Server and how to install them,
see the following: What is Connection Manager

Note
ADS 2011 Connection Manager is built on the core version of Connection Manager Server that was shipped
originally with ADS 2006 Update 3.

 Before You Begin
To communicate with instruments, you must install the Connection Manager server.
Before installing the server, ensure that your PC workstation and your EDA software
licensing meet the following requirements.

  

 System Requirements

The server must be installed on a true 32-Bit Windows XP PC workstation connected to the
same network as the EDA software network server or local installation. If you intend to
use ADS installed on any other operating system (OS) (Ex: any 64-Bit WindowsXP, any
32/64-Bit Windows Vista, Linux, or Solaris OS...)  that is not supported directly by ADS
Connection Manager Server, consider the following alternative configuration [Dual
Workstation/Remote IO Link Configuration "B"] as described in the following ADS support
document:

https://edasupportweb.soco.agilent.com/portal/page?_pageid=36,
39953&_dad=portal&_schema=PORTAL&itemid=318418

http://www.home.agilent.com/agilent/download.jspx?cc=US&amp;lc=eng&amp;nid=-34346.870673&amp;pageMode=DL
http://www.home.agilent.com/agilent/download.jspx?cc=US&amp;lc=eng&amp;nid=-34346.870673&amp;pageMode=DL
http://edocs.soco.agilent.com/display/eesofkc/What+is+Connection+Manager
http://edocs.soco.agilent.com/display/eesofkc/What+is+Connection+Manager
https://edasupportweb.soco.agilent.com/portal/page?_pageid=36,39953&amp;_dad=portal&amp;_schema=PORTAL&amp;itemid=318418
https://edasupportweb.soco.agilent.com/portal/page?_pageid=36,39953&amp;_dad=portal&amp;_schema=PORTAL&amp;itemid=318418
https://edasupportweb.soco.agilent.com/portal/page?_pageid=36,39953&amp;_dad=portal&amp;_schema=PORTAL&amp;itemid=318418
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Note
Connection Manager Server cannot be installed on 64-bit machines.

Requirement Description

 Processor Pentium III 450 MHz or higher

 RAM 256 MB

Hard Disk Space 500 MB on system drive

Operating System Windows XP Professional (Service Pack 1 or Service Pack
2)

Network
Configuration

TCP/IP

Supported Media Type CD-ROM required for program installation.

Caution
If you have Toshiba Bluetooth Stack installed on your system, you must uninstall it before installing
Connection Manager server. Installing Toshiba Bluetooth Stack and Connection Manager server on the
same system may cause undesirable effects including a system crash. To uninstall Toshiba Bluetooth
Stack on Windows, choose Start > Control Panel > Add or Remove Programs, then locate the
program and select Remove.

You can install Windows native Bluetooth drivers to use Bluetooth devices.

    

 Licensing Requirements

Although the Connection Manager client requires a license, Connection Manager server
does not require a license regardless of where it is installed.

Note
The Connection Manager client is installed during the main software installation. The link_connect_mgr
license is required to run the client from a schematic page. Connection Manager client and server
installations are not related to the client-server installation of the EDA software.

  

 EDA Software Version Requirements

The Connection Manager client and server software must be from the same or compatible
release. If you have been using an older release of Connection Manager, then you install
ADS 2009 Update 1 on a client system, you also must install a compatible release of the
server software. Since the Connection Manager server was not updated for ADS 2009
Update 1, the compatible release for ADS 2009 Update 1 is ADS 2006 Update 3.

  

 Installation Package Overview

The Connection Manager server installation installs all the software necessary to enable
the EDA software-supplied measurements. This includes:

Run-time versions of the Agilent Test and Measurement Programmer's Toolkit. This
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includes the most recent version of VISACom available when the Toolkit was
released. The latest version is available from the Agilent Developer Network at:
http://adn.tm.agilent.com
The Agilent IO Libraries
ADS Measurement Libraries
Run-time versions of Microsoft .NET, suitable for running .NET application
The Connection Manager server

 

 Installation Types

 

 Complete

The Complete installation installs all program features in the default installation directory
C:\Program Files\Agilent\Connection Manager Server.

 

 Custom

The Custom installation lets you define the installation directory and choose the optional
program features, such as the ADS Measurement Library, Connection Manager
documentation, Ptolemy VEE Link Server, and VEE Service Control Panel Application.

  

 Installing the Server
Ensure that your PC workstation meets the system requirements.1.
Insert the Connection Manager Server 2006 Update 3 Installation Disc into the2.
workstation CD-ROM drive.
When the installation wizard prompts you, choose the type of installation.3.
Follow the command prompts to complete the installation.4.

 

 For Windows XP Service Pack 2 Systems Only

When the system reboots, Connection Manager Server starts and the Windows1.
Security Alert dialog appears.

http://adn.tm.agilent.com
http://adn.tm.agilent.com
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In the Windows Security Alert dialog, click Unblock.2.
This creates an exception in the Windows Firewall that allows network connections
through the firewall to the Connection Manager server.

This completes the installation process. To connect instruments to the server workstation,
complete the steps in Configuring the Server IO on the PC.

  

 Configuring the Server IO on the PC
Prior to using Connection Manager for the first time, you must configure the IO on the
server workstation.

This section provides instructions for automatically configuring common LAN and GPIB
interfaces, and for manually configuring other interfaces such as LAN/GPIB gateways.

To Configure Common LAN or GPIB Interfaces provides simplified instructions to configure
a common LAN or GPIB interface.

To manually configure an available interface (for example, the Agilent E5810A LAN/GPIB
gateway), see To Manually Configure Other Interfaces.

 

 Additional Resources

For detailed information on IO configuration, refer to the documentation for the IO
libraries.

Choose the IO icon in the tool bar, then choose View Documentation.

Also, see "Configuring IO Interfaces" in Agilent IO Libraries Installation and Configuration
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Guide for Windows, available in PDF format at: http://www.agilent.com/find/iolib .

Note
Connection Manager server does not support the use of National Instruments IO connectivity products.
The Connection Manager server relies entirely on the Agilent IO libraries to provide instrument
connectivity, and cannot offer support for National Instruments IO products.

  

 To Configure Common LAN or GPIB Interfaces

To auto-configure the I/O and connect instruments to the server using a LAN or GPIB
interface:

 In the server's Windows system tray, select IO > Run IO Config.1.
This opens the IO Config dialog. The Available Interface Types group box lists the IO
types supported by the Agilent IO Libraries. List entries with an asterisk ( * ) can be
automatically configured in step 2.
 To automatically configure common LAN and GPIB interfaces in the IO Config dialog,2.
select Auto Config.
Auto-configured interfaces appear in the Configured Interfaces group box, as shown.

 

 If you encounter a problem

http://www.agilent.com/find/iolib
http://www.agilent.com/find/iolib
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  For GPIB interfaces, ensure that the GPIB interface is installed/connected to the server.

For LAN interfaces, the IO auto-configuration routine creates a TCPIP network tunnel and
displays TCPIP lan in the Configured Interfaces group box. The routine creates only one
TCPIP interface regardless of the number of LAN cards installed on the server workstation.

Follow the steps in To Connect Instruments to the Server through the LAN to complete the
LAN interface configuration.

  

 To Connect Instruments to the Server through the LAN

Unlike GPIB interfaces where instruments communicate directly with the server via an
exclusive bus, the Agilent IO libraries do not dynamically discover instruments connected
to the server via LAN. You must manually add LAN devices to the server IO.

To add LAN devices:

 In the IO Config dialog, highlight TCPIP0 in the Configured Interface group box and1.
click Edit.
In the LAN Client dialog, click Edit VISA Config.2.
In the TCPIP devices dialog, click Add device.3.
In the Add a TCPIP device dialog Machine Name/IP field, enter the IP address of4.
the instrument you would like to connect to the server and click OK.

In the TCPIP devices dialog, click OK.5.



Advanced Design System 2011.01 - Windows Installation

66

In the LAN Client dialog, click OK.6.
In the IO Config dialog, click OK.7.

 

 If you encounter a problem

 Ensure the following conditions are met:

The server is connected to the LAN.
The instrument is connected to the LAN.
The instrument line power is switched on.
The LAN is operational.

 

 To Manually Configure Other Interfaces

This section explains how to manually configure an IO that cannot be auto-configured by
the Agilent IO Library. This section explains how to configure a LAN/GPIB gateway, such
as the Agilent E5810A.

 To manually configure a LAN/GPIB gateway.

 In the Windows system tray, select IO > Run IO Config.1.
 In the Available Interface Types group box, highlight VISA LAN Client Interface2.
(E5810A) and click Configure.
In the VISA LAN Client Interface (LAN to GPIB) dialog Local Settings group box, use3.
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the scroll box to choose a VISA Interface Name.
In the Remote Settings group box, enter the hostname or IP address of the LAN/GPIB4.
gateway.
In the Remote Settings group box, enter the SICL interface name assigned to the5.
LAN/GPIB gateway (or other network interface device) and click OK.
During the process of configuring the LAN/GPIB gateway, you must assign a SICL
interface name to the device. You must enter the same SICL interface name in the
Remote SICL Interface Name data entry field.

In the VISA LAN Client Interface (LAN to GPIB) dialog, click OK.6.

 To exit the IO configuration without connecting instruments to the server, in the IO
Config dialog click OK. To connect instruments to the server, follow the steps in To
Connect Instruments to the Server through the LAN.

 

 If you encounter a problem

Ensure the following conditions are met:

The server is connected to the LAN.
The LAN is operational.

 

 Using Connection Manager with Windows XP Service
Pack 2
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By default, computers using Windows XP Service Pack 2 will not allow access to the
Connection Manager server and VEE Service through the firewall.

If you have upgraded from another operating system version to Windows XP Service Pack
2, you must enable connections to the PC hosting the Connection Manager server and/or
VEE Service by listing them as exceptions to the firewall.

To enable network connections to Connection Manager server (and VEE Pro, if necessary)
through the firewall:

In the Windows menu bar, choose Start > Settings > Control Panel.1.
In the Control Panel dialog, click Windows Firewall.2.

In the Windows Firewall dialog, ensure that the Don't allow exceptions checkbox is3.
unchecked.
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In the Windows Firewall dialog, click the Exceptions tab.4.
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In the Exceptions tab, click Add Program.5.
In the Add a Program tab, click Browse.6.
Use the Browse dialog to enter the Connection Manager Server installation directory7.
(by default, <installation drive>\Program Files\Agilent\Connection Manager Server).
From the Connection Manager Server installation directory, choose MsmtSrvr.exe8.
and click Open.
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In the Add a Program tab, click OK.9.
The Windows Firewall dialog Exceptions tab shows the MsmtSrvr.exe exception.
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If you are using VEE Service, in the Exceptions tab, click Add Program....10.
In the Add a Program tab, click Browse.11.
Use the Browse dialog to enter the VEE Pro installation directory (by default,12.
<installation drive>\Program Files\Agilent\VEE Pro 7.0).
From the VEE Pro installation directory, choose veesm.exe and click Open.13.
In the Add a Program tab, click OK.14.
In the Windows Firewall dialog, click the OK.15.

Connections to the PC hosting the Connection Manager server and/or VEE Service are now
enabled as firewall exceptions.

 

 Running the CM Server as a Windows Service
By default, the Connection Manager server runs as a Windows application. If preferred,
the server can run as a Windows service.

For instruction on configuring the server to run as a Windows service, see Running the
Server as a Windows Service in the Connection Manager documentation.
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